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Preface

Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©March 2016

Trademarks
Intel, Pentium and Intel Core are trademarks/registered trademarks of Intel Corporation.
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R&TTE Directive
Thisdeviceisin compliance with the essential requirements and other relevant provisions of the R& TTE Direc-
tive 1999/5/EC.

Thisdevice will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

ErP Off Mode Power Consumption Statement:
Thefigures below note the power consumption of thiscomputer in compliance with European Commission (EC)
regulations on power consumption in off mode:

« Off Mode <0.5W
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CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters“CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark

is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R& TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and hasissued afavorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement

(Federal Communications Commission)

Y ou are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limitsfor aClass B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonabl e protection against harmful interferencein
aresidential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, thereisno guarantee that interference will not occur in aparticular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on acircuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:
1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator

and your body.

N2
2

Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the

equipment.




Preface

IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.

4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

5. This product is intended to be supplied by a Listed Power Unit according to the model’s requirements:

Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz, DC Output 19V, 2.1A (40W) minimum.

Vi



Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions.

1.

Preface

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.

surface.

Do not placeit on an unstable

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

Do not leaveit in a place
where foreign matter or mois-
ture may affect the system.

Don't use or store the com-
puter in a humid environment.

Do not place the computer on
any surfacethat will block the
Vents/Fan Intakes.

Vi
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don'’t forget

to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance
on your computer.

VIiI

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.




Preface

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and may expose you and
the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from
the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

»  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

* If the computer does not work normally when you follow the operating instructions.

* If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
* If thereisan unusua odor, heat or smoke coming from your computer.

\ A/
LS
Bottom Cover Removal Warning

Users should not remove any cover(s) and /or screw(s) for the purposes of device upgrade as this may violate the terms of
your warranty. If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please contact your dis-
tributor/supplier for further information.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and

screw(s) before restoring power to the system.
Also note the following when the cover is removed:

e Hazardous moving parts.
* Keep away from moving fan blades.
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Power Safety
The computer has specific power requirements:

ﬁ * Only use apower adapter approved for use with this computer.
* Your AC/DC adapter may be designed for international travel but it still requires a steady,
Power Safety uninterrupted power supply. If you are unsure of your local power specifications, consult
L) your service representative or local power company.

Before you undertake » The power adapter may have either a2-prong or a 3-prong grounded plug. Thethird prong
any upgrade proce- isan important saf ety feature; do not defeat its purpose. If you do not have accessto a
dures, make sure that compatible outlet, have aqualified electrician install one.
VEIEVERTIGEEREIGES  « \When you want to unplug the power cord, be sure to disconnect it by the plug head, not by
power, and discon- itswire.

nected all peripherals
and cables (including
telephone lines and

» Make sure the socket and any extension cord(s) you use can support the total current load
of al the connected devices.

power cord). + Before cleaning the computer, make sure it is disconnected from any external power sup-

plies (i.e. AC/DC adapter or car adapter).

You must also remove

your battery in order to

prevent accidentally Do not plug in the power Do not use the power cordif | Do not place heavy objects

turning the machine cord if you are wet. it is broken. on the power cord.

on. Before removing

the battery discon-

nect the AC/DC

adapter from the

computer.
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Polymer Battery Precautions

Note the following information which is specific to polymer batteries only, and where applicable, this overrides

the general battery precaution information overleaf.

» Polymer batteries may experience aslight expansion or swelling, however thisis part of the battery’s safety mecha-
nism and is not a cause for concern.

e Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See a'so the general battery precautionary information overleaf for further information.

Xl
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General Battery Precautions

» Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

» Do not remove any batteries from the computer while it is powered on.

» Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
resultinfire.

» If you do not use the battery for an extended period, then remove the battery from the computer for storage.

» Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

» Donot try to repair abattery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

» Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

» Keep the battery away from metal appliances.

» Affix tape to the battery contacts before disposing of the battery.

» Do not touch the battery contacts with your hands or metal objects.

\ A/
2R
Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,

under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.

Xl
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Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply and then refer servicing to qualified service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

 |If the computer does not work normally when you follow the operating instructions.

 If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
» If thereisan unusual odor, heat or smoke coming from your computer.

S
&
Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before restoring power to the system.

Also note the following when the cover is removed:

e Hazardous moving parts.
* Keep away from moving fan blades.

X1l
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Travel Considerations
Asyou get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-
ware and software. Make sure your “papers” are handy.

SN
L&

Power Off Before Traveling

agprwbNPE

N o

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer
from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.

XV
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these pointsin mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’'t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Bewar e of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
Theserestrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power whereyou can - If an electrical outlet isavailable, usethe AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from acold to awarm location, water vapor can condense inside the computer.
Wait afew minutes before turning it on so that any moisture can evaporate.

XV
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Developing Good Work Habits

Developing good work habitsisimportant if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

» Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the
level of your elbow. Keep your forearms, wrists, and hands in arelaxed position.

*  Your knees should be slightly higher than your hips. Place your feet flat on the floor or on
afootrest if necessary.

* Useachair with aback and adjust it to support your lower back comfortably.

»  Sit straight so that your knees, hips and elbows form approximately 90-degree angles
when you are working.

»  Take periodic breaksif you are using the computer for long periods of time.

Remember to:

e Alter your posture frequently.

e Stretch and exercise your body several times a day.

e Take periodic breaks when you work at the computer for long periods of time. Frequent
and short breaks are better than fewer and longer breaks.

XVI
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatiguein your neck and
shoulders.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image per sistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plansto turn the screen off after afew minutes of screenidle time.

Use arotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system isnot in use.

LCD Electro-Plated Logos

Note that in computers featuring araised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear develops contact your distributor/supplier.

|
XVII
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

e Chapter 2 A guideto using some of the main features of the computer e.g. the stor age devices (hard disk,
optical device, Multi-in-1 card reader), TouchPad & Mouse & Audio.

e Chapter 3  The computer’'s power saving options.

e Chapter 4 Theinstalation of the driversand utilities essential to the operation or improvement of some of the
computer’s subsystems.

e Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

e Chapter 6 A quick guide to the computer’s PC Camera, WirelessLAN and Combo Bluetooth & WLAN
modules (some of which may be optional depending on your purchase configuration).

e Chapter 7 A troubleshooting guide.

» Appendix A Definitions of the interface, portg/jackswhich allow your computer to communicate with external
devices.

» Appendix B Information on Control Center.

» Appendix C Information on the Video driver controls.

» Appendix D The computer’s specification.

e Appendix E Information on the Windows 7 operating system.

» Appendix F Information on the Windows 10 operating system.

. |
Overview 1 -1
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page4 - 1 and “BIOS Utilities” on page5 - 1 in the remainder of the User’'s
Manual. Y ou may also find the notes marked with a /Z of interest to you.

Beginners and Non-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them) then
4 the information contained in the Quick Start Guide should be enough to get you up
Notes and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the
boxes with the mark | remainder of the User's Manual), but do not worry if you do not understand every-
above to find detailed in- = thing the first time. Keep this manual nearby and refer to it to learn as you go. You
utors foatiroe. <™ | may find it useful to refer to the notes marked with a s indicated in the margin,
For amore detailed description of any of the interface ports and jacks see “ I nterface

(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overview
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Not Included
Operating Systems (e.g. Windows 8.1) and applications (e.g. word processing, spreadsheet and database pro-
grams) have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “ Drivers & Utilities (Win 8.1)” on page 4 - 1. Drivers are programs which act as an interface between
the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers
in the order listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly
installed. If your system hasn’t been properly configured (your service representative may have already done that for you);
refer to Chapter 4 for installation instructions.

Ports and Jacks

See “Interface (Ports & Jacks)” on page A - 1 for a description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.

. |
Overview 1 -3



Quick Start Guide

System Startup

1. Remove all packing materials, and place the computer on a stable surface.

2. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.

3. Attach the AC/DC adapter to the DC-In jack on the right of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter (make sure you use the adapter when first
setting up the computer, as to safeguard the computer during shipping the battery will be locked to not power
the system until first connected to the AC/DC adapter).

4. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 130 degrees); use the other
hand to support the base of the computer (Note: Never lift the computer by the lid/LCD).

4

Shutdown

130°

Note that you should
always shut your com-
puter down by choos-
ing the Shut Down
command in Win-
dows (see page 1 -
28). This will help pre-
vent hard disk or sys-
tem problems.

Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-In

1 -4 System Startup
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Model Differences

Note that though your computer’ s design may look, or be colored, slightly different from that pictured through-
out this manual, all ports, jacks and general functions are the same for all design styles.

System Software

Y our computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for adifferent system, you will find the Windows 8.1 operating system is sup-
ported.

Note: In order to run Windows without limitations or decreased performance, your computer requires a mini-
mum 2GB of system memory (RAM).

4

Windows Versions

Note that the information included on the following pages is for Windows 8.1 (64-bit) only. See Appendix E for informa-
tion on the drivers and utilities for Windows 7 (64-bit) only.

Windows OS

In order to run Windows 8.1 (64-bit) or Windows 7 (64-bit with Service Pack 1) without limitations or decreased per-
formance, your computer requires a minimum 2GB of system memory (RAM).

L_________________________________________________________________________________________________________________________________________________|
System Startup 1 -5
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Figure 1 -2
LCD Panel Open

Built-in PC Camera
PC Camera LED
Built-In Microphone
LCD*

Power Button
Keyboard
Touchpad & Buttons

NookrwbdpE

Note that the Touchpad and
Buttons has a valid opera-
tional area indicated within
the dotted lines above.

System Map: LCD Panel Open
(2 o (3

1 -6 System Map: LCD Panel Open

N
PR
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the WLAN, Bluetooth and
3G/4G modules) are OFF
(or the system is in Air-
plane Mode) if you are us-
ing the computer aboard
aircraft (see

)-




LED Indicators

The LED indicators on the computer display helpful information about the current status of the computer.

Quick Start Guide

Icon Color Description
Orange DC Power is Plugged In
Green The Computer is On

Blinking Green

The Computer is in Sleep Mode

Orange

The Battery is Charging

Green

The Battery is Fully Charged

Blinking Orange

The Battery Has Reached Critically Low Power Status

Off Battery Charging has been Disabled
Green Hard Disk Activity
Green Airplane Mode is ON (the WLAN, Bluetooth & 3G/4G Modules are OFF)

Table 1 -1 - LED Indicators

LED Indicators 1 -7
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4

Other Keyboards

Keyboard

The keyboard has an embedded numerical keypad for easy numeric data input, and
function keys to change operational features instantly.

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-

cial  functions/hot-keys

unique to the system’s Numerical Keypad

regular keyboard may not
work. o
Menu/Application Key
Windows Logo Key
Hold down the Fn Key

NumLk & ScrLk
and either NumLk or ;
Figure1-3-K r
ScrLk to enable number gure 3 eyboa d
or scroll lock, and check
the LED indicator for sta- /
tus.

NumLk &
ScrLk Keys

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

1 - 8 Keyboard
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Keyboard Shortcuts

The following Windows Logo Key (Winkey) keyboard shortcuts are useful for navi- 4

gation/operation in Windows 8.1. Windows Logo
Keyboard Shortcut

Windows Logo . :
Description Use the Windows logo

am Key + key 3@ + D key com-
bination to switch
from the Start screen
to the Windows Desk-
C Display Charms menu top.
Menu/Application
Keyboard Shortcut

Toggle between the Start screen and the foremost running app or the

Tap Winkey Windows Desktop

D Switch to the Windows Desktop and toggle show Desktop

Switch to the Windows desktop and launch Windows Explorer with

Computer displayed When the Desktop app
iS running you can use
the Menu/Application

I Open the Settings charm key |E| on the key-
board to act as a

F Display file Search

K Open the Connect charm mouse right-click. In

L Lock the computer and display the Lock screen the Start screen this
- - function is useful to

P Display the Second Screen menu (see Figure 1 - 17 on page 1 - 25) quickly display Cus-

R Switch to the Windows Desktop and display the Run dialog box tomize Apps.

z Access the Customize Bar (see Figure 1 - 12 on page 1 - 20)

Table 1 - 2 - Keyboard Shortcuts

Keyboard 1-9
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Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations, some visual indicators are available when the hot key utility isinstalled.

Keys Function Keys Function
Fn + Play/Pause (in Audio/Video Programs) Fn+ Brightness Decrease/Increase
PC Camera Power
Fn + TouchPad Toggle Fn + Toggle
Fn + Turn LCD Backlight Off Fn + Airplane Mode Toggle

(Press a key to or use TouchPad to turn on)

Fn+ Mute Toggle Fn + Number Lock Toggle
Fn + Sleep Toggle Fn + Scroll Lock Toggle
Fn + Volume Decrease/Increase Caps Lock Toggle
Fan Control Toggle
Fn+ Display Switch Menu Fn + Automatic Fan Control /
Full Power

Table 1 - 3 - Function & Hot Key Indicators

.|
1-10 Function/Hot Key Indicators
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Control Center

When in the Windows Desktop application (not in the Start screen) press the Fn + Esc key combination, or
double-click theicon  inthenactification area of thetaskbar to toggle the Control Center on/off. The Con-
trol Center givesquick accessto frequently used controls and enables you to quickly turn the camera/touch pad
on/off (see Appendix B for full details).

4

Control Center Access

To run the Control Center press the Fn + Esc key
combination, or double-click the icon in the
notification area of the taskbar.

Close the Control

Center by clicking
the close icon in O
the top right of the
panel (move the cur-
sor onto the top right

corner of the panel
. to highlight it).

Figure 1 - 4 - Control Center

Control Center 1 - 11
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Figure 1- 5 System Map: Front & Left Views

Front & Left Views

1. LED Indicators
2. External Monitor o
Port
3. Vent/Fan Intake/ o
Outlet
4, HDMI-Out Port
5. USB 3.0 Port
6. Microphone-In (2] (3] ® 6 00
Jack '
7. Headphone-Out
Jack Z

USB 3.0 Port OR USB 2.0 Port

This model includes 1 * USB 3.0 port and 2 * USB 2.0 ports. The USB 3.0 port is denoted
by its blue color; the USB 2.0 ports are colored black.

Optical Device Drives

To install applications and drivers etc. you will need to attach an external optical CD/DVD
device to the USB ports.

HDMI Port

Note that the HDMI Port supports video and audio signals to attached external displays.

.|
1-12 System Map: Front & Left Views



System Map: Right & Rear Views

e

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges. See “Battery Information” on page 3 - 14 for full instructions.

Multi-In-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RS MMC
SD (Secure Digital) / Mini SD / SDHC / SDXC

Quick Start Guide

Figure1-6
Right & Rear Views

1. Security Lock
Slot

DC-In Jack

3. RJ-45 LAN Jack
4. Multi-in-1  Card

N

Reader
5. 2*USB 2.0 Ports
6. Battery

4

USB 3.0 Port OR USB
2.0 Port

This model includes 1 *

USB 3.0 port and 2 *
USB 2.0 ports. The USB
3.0 port is denoted by its
blue color; the USB 2.0
ports are colored black.

System Map: Right & Rear Views 1 - 13
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Figure 1-7
Bottom View

1. Battery

2. Vent/Fan Intake/
Outlet

3. Speakers

RS
Overheating

To prevent your comput-
er from overheating
make sure nothing blocks
the Vent/Fan Intake while
the computer is in use.

System Map: Bottom View
(1

2NZ
2L &

Bottom Cover Removal Warning
Do not remove any cover(s) and /or screw(s) for the purposes of device upgrade as this may
violate the terms of your warranty.

If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please
contact your distributor/supplier for further information.

1-14 System Map: Bottom View
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Removing/Inserting the Battery

Follow the procedure below if you need to remove the battery.

Turn the computer off, and turn it over.

Slide the latch @ in the direction of the arrow.

Slide the latch @ in the direction of the arrow, and hold it in place.
Slide the battery out in the direction of the arrow @.

Reinsert the battery as illustrated below @.

Make sure the latches are returned to the lock position @.

ok wbpE

(3]
(2] o

Figure 1 -8
Battery Removal &
Insertion

Removing/Inserting the Battery 1 - 15
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Windows 8.1 Control Panel

4
, _ Throughout this manual you will see an instruction to open the Control Panel.
Windows Versions £ pjght-click the lower left hot corner to bring up the context menu (or use the Win-
Note that the informa- || dowsLogo Key @ + X key combination) and select Control Panel in both the

tion included on the fol- Desktop app or Start screen.
lowing pages is for the
latest updated version

of Windows 8.1 only.

Make sure you enable

Windows Update in or- Desktop app
der to get all the latest

security updates etc.

(see “Windows Up-

date” on page 4 - 9).

O~ <

Figure 1 - 9 - Windows Context Menu
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The Control Panel can be accessed in a number of waysin Windows 8.1.
» Click Search inthe Windows Charms Bar (see previous page) and the search pane will pop out. Type
Control Panel and select it from the results to the left.

* Click on ThisPC (in Apps, or you canto pin This PC to the Start screen), click on Computer in the
top menu and select Open Control Panel from the ribbon.

* When in the Desktop app (this does not apply to the Start screen) click on Settingsin the Windows
Charms Bar and select Control Panel from the menu.

* Click thearrow at the bottom of the Start screen and click Control Panel in Apps (Windows System).
* Right-click the Start button to bring up the menu and select Control Panel (see Figure 1 - 10 on page 1
- 18).

4

Keyboard Shortcut to Control Panel

You can also use keyboard shortcuts to access the Control Panel. Press the Windows logo key == and X to bring up
the context menu, and then press P to bring up the Control Panel. Alternatively press the Windows logo key == and R
to bring up the Run dialog box, and then type “Control Panel” and press Enter to access the Control Panel.

Windows 8.1 Control Panel 1 -17
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Right-click the Start button in the Desktop app (or use the Windows Logo Key

4 28 + X key combination) to bring up an advanced context menu of useful features
Display Most such as Control Panel, Programs and Features, Power Options, Task Manager,
Recently Used Search, File Explorer, Command Prompt, Device Manager and Network Connec-

Apps tions etc.

If you are in the Start
screen, Desktop or an
app you can move your
mouse to the upper left
corner of the screen to

get back to the most re-
cently used app.

To view all the most re-
cently used Apps hover
over the top left of the
screen and then move
the mouse down along
the left side of the
screen to display the
list.

Move the mouse to the bottom left of the screen
and right-click the Start button to access the menu.

Figure 1 - 10 - Advanced Context Menu (Right-Click Start Button)
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Windows 8.1 Start Screen & Desktop

The Apps, control panels, utilities and programs within Windows are accessed from the Start screen and/or
Windows Desktop app. The Desktop (which runsasan app within the Start screen) can be accessed by clicking
the Desktop item in the Start screen (or by using the Windows L ogo Key g@ + D key combination). Click the
arrow at the bottom of the Start screen to access Apps.

Figure 1 - 11 - Windows Start Screen
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Apps & Tiles

The Start screen will contain a number of apps, and many more will be installed as you add more applications
etc. Not all of these apps can fit on one screen so you will often need use the dlider at the bottom of the screen
in order to view all the necessary Apps.

Accessing Pining/Unpinning All Apps

Y ou can add and remove thetiles for apps and control panelsin the Start screen. Right-click on an app to bring
up the context menu and you pin the App to (or unpin from) the Start screen, or to the taskbar.

Figure 1-12 - Apps

1-20 Windows 8.1 Start Screen & Desktop



Quick Start Guide
Desktop Application

When the Desktop app is running (click the app in the Start screen or use the Windows Logo Key g@ + D key
combination) you can use lower left hot corner to switch between the Start screen and the Windows Desktop
app. To do so move your mouse to hover over the bottom left corner of the Desktop app and left-click.

Move the mouse to the bottom left of the screen and click to switch
back to the Start screen.

Figure 1 - 13 - Desktop

.|
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The Charms Bar

Theright side of the screen (Start or Desktop) displaysthe CharmsBar. The CharmsBar containsthe Sear ch,
Share, Start, Devicesand Settings menus. To access up the Charms Bar move the cursor to the upper or lower
right corners of the screen, and then hover over one of the itemsin the Charms Bar to activate it (the bar will
be black when it is active), or use the Windows L ogo Key g@ + C key combination.

Figure 1 - 14 - Start Screen with Charms Bar
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Charms Bar Items

Search E: You can search for any file, application, Apps and control panel settings with instantaneous
results.

Share @) This button is used to share information with people viamail or social networks.

Sart .: Click to bring up the Start screen (the same function as pressing the Windows Logo Key or click-
ing the bottom left of the screen).

Devices B3] Click this button to change connected peripheral device settings e.g. an external display.

SettingsE]: This button gives instant access to the computer settings, such as Network, Audio, Notifica-
tions, Power and Keyboard (click Change PC Settingsto activate the PC Settings menu).

4

Charms Bar - TouchPad Access
To quick access the Charms Bar using the TouchPad:

1. Place your finger off the TouchPad (slightly to the right of the
pad resting on the computer).

2. Move your finger across to the left on to the TouchPad.

3. The Charms Bar will then pop-up.

Figure 1 - 15 - Settings Menu
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Windows 8.1 Taskbar

In many instances throughout this manual you will see an instruction to access the notification ar ea of the task-
bar (system tray). In Windows 8.1 the taskbar can be directly accessed from the Desktop application; if you
arein the Start screen you will need to move the cursor to the bottom of the screen to display the taskbar.

The taskbar is displayed at the bottom of the screen, and you can see the notification area (system tray) of the
taskbar in the bottom right of the screen. Some of the control panels and applications referred to during the
course of this manual can be accessed from here.

Figure 1 - 16 - Taskbar & Notification Area (System Tray)

Y ou can pin/unpin appsto/from the taskbar in much the same way asyou can to the Start screen (see“ Accessing
Pining/Unpinning All Apps’ on page 1 - 20).
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Video Features

Y ou can switch display devices, and configure display options, from the Display control panel (in Appear ances
and Per sonalization) in Windows when running the Desktop app (see “ Desktop Application” on page 1 - 21).
It is possible to quickly configure external displays from the Devices menu item in the Charms Bar (see“ The
CharmsBar” on page 1 - 22).

To Configure Displays from Devices (Charms Bar):

1. Attach your display to the appropriate port, and turn it on.

2. Gothe Charms Bar, select Devices.

3. Click Project (you may need to click Second Screen).

4. Click on any one of the options from the menu to select PC screen only, Duplicate, Extend or Second screen
only.

Figure 1 - 17 - Devices (Project)
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To access Display (Control Panel) and Screen Resolution in Windows 8:
1. Gotothe Control Panel.

2. Click Display (icon) - In the Appearance and Personalization category.
3. Adjust resolution.

4

Right-Click Desktop
App

You can right-click
the desktop and
select Screen reso-
lution @ (Figure 1 -
0 @ 18).
. Use the dropbox to
select the screen
[3) Resolution @
(Figure 1 - 18).
Click Advanced
settings @ (Figure
1 - 18) to bring up the
Advanced
properties tabs.

Figure 1 - 18 - Screen Resolution

1 - 26 Video Features



Quick Start Guide

To access the I ntel (R) HD Graphics Control Panel:

1. Click Advanced settings @ (Figure 1 - 18 on page 1 - 26) in the Screen Resolution control panel in Win-
2. dC(I)i(\;\LSt.he Intel(R)... tab and click Graphics Properties (button) @ (Figure 1 - 19 on page 1 - 27) .

SR Right-click the desktop and select Graphics Properties from the menu.

El).R Click the icon in the notification area of the Desktop taskbar and select Graphics Properties from the menu.

Figure 1 - 19 - Intel Graphics Control Panel
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Power Options

Power Options (Hardwar e and Sound) can be accessed from the Control Panel. The Power Menu itemin Set-
tingsin the Charms Bar in Windows 8.1 may be used to Shut down or Restart (you can also add Hiber nate/
Sleep to the menu - see “ Adding Hibernate/Sleep to the Power Menu” on page 3 - 10). You can also use the
context menu (Shut down or sign out) shut the computer down/restart etc.

Power Button Start Screen Desktop App Start Screen

Charms Bar

> O

Figure 1 - 20 - Shut Down/Restart
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Running Apps
To run appsin Windows 8.1 you will need to check that the Screen Resolution and User Account Contr ol Set-
tings are compatible with the system requirements.

Screen Resolution Settings

1. Switch to the Windows Desktop (click the app or use the Windows logo key &@ + D key combination).

2. Right-click a blank area of the Windows Desktop and select Screen Resolution. Adjust the Resolution to
make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above (see sidebar).

Screen Resolution for Apps
(Windows 8.1)

The minimum resolution in which Apps will run is 1024x768.

The minimum resolution required to support all the features of
| 1 Windows 8 (including multitasking with snap) is 1366x768.

These specs are the minimum screen resolution that supports
all the features of Windows 8.1 on a useful physical size.

Figure 1 - 21 - Screen Resolution

.|
Running Apps 1-29



Quick Start Guide

User Account Control Settings

If your computer meets the minimum screen resol ution requirements, and still you can't run apps, then that you
have to check the status of User Account Control (UAC). Apps may fail to open when the UAC is turned off.
To check whether the UAC is on or off, follow the instructions below.

1. Open the Control Panel.

2. Click on User Accounts and then click on Change User Account Control settings (or click System and
Security and click Change User Account Control Settings under Action Center).

3. Ifthe slider is in the Never notify position, then the UAC is disabled.

4. To enable or turn on the UAC, move the slider to Always notify or Notify me when apps try to make changes
to my computer (default) position, and then click OK.

Figure 1 - 22 - User Account Control

.|
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Chapter 2. Features & Components

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive/Solid State Drive/
Multi-In-1 Card Reader

Touchpad and Buttons/Mouse
Audio Features

. |
Overview 2 - 1
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e Hard Disk Drive/Solid State Drive

T - The hard disk drive (HDD) and/or solid state drive (SSD) is used to store your data
Removal Warning inthe computer. The hard disk can betaken out to accommodate other serial (SATA)
hard disk drives (see “ Storage” on page D - 2 for specification information), how-

SRR ever you will need to contact your distributor/supplier to do this in order to avoid

er(s) and /or screw(s) for

upgrade as this may vio-

late thte SuERa R CHER  The solid state drive is afactory option for this computer model.
warranty.

If you need to replace/
remove the hard disk for
any reason, please con-
tact your distributor/sup-
plier for further
information.

2 - 2 Hard Disk Drive/Solid State Drive
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Multi-In-1 Card Reader

The card reader alows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the card reader driver (see

“CardReader” on page4 - 7).

« MMC (MultiMedia Card) / RSMMC
« SD (Secure Digital) / Mini SD / SDHC / SDXC

*Note: The PC adapters are usually supplied with these cards.

(1) Figure2-1
Right View

1. Card Reader

. |
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P Touchpad and Buttons/Mouse
. The Touchpad is an alternative to the mouse; however, you can also add a mouse to
TOUCTad Active your computer through one of the USB ports. The Touchpad buttons function in
reas much the same way as a two-button mouse.
Note that the pointing e
active area is clearly TOUChpad SenS|t|V|ty
defined from the but- The mouse button zones at the bottom of the pad are defined by the line at the bot-

ol EEIVE Elea &5 1 tom of the pad, and the left and right buttons are divided roughly down the middle

lustrated. as illustrated below. The active area of the touchpad is that defined in the diagram
below. Press the left button zone for a left click, and right button zone for a right
click action.
Figure2- 2
Touchpad
Sensitivity
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Once you have installed the Touchpad driver (see “ Touchpad” on page4 - 7) you
can configure the functions by double-clicking the Touchpad driver icon in the
notification area of the taskbar. Y ou may then configure the Touchpad tapping, but- Touchpad Scrolling
tons, scrolling (see sidebar), pointer motion and sensitivity options to your prefer-

This computer model se-
ences.

ries may feature different
Touchpad versions.

These Touchpads may
differ in their vertical
scrolling function in most
scrollable windows.

Some Touchpads require
sliding the finger up and
down on the right of the
Touchpad to scroll the
window. Other versions
require  tapping/holding
down the finger at the top
right or bottom right of the
Touchpad to scroll the
window.

Figure2-3
Mouse Properties
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5 Gestures and Device Settings
. 4 The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
Show Video tion) on the surface of the Touchpad to perform specific actions to manipul ate doc-
You can get a clearer uments, objects and applications.
view of the gestures in- . . . . . .
volved by clicking the Y ou can configure the settings from the Device Settings tab in M ouse Properties:

Show Video option for
each gesture item.

=

Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Mouse (Hardware and Sound).

Select the gesture (Pinch 3. Click Device Settings (tab) and click Settings.
4

Zoom, Rotating, Three Use the menu tree on the left to access the user configurable settings.
Fingers Down and

Three Finger Flick) in the
Device Settings > Set-
tings left tree menu

and click the Show Video
button to see the demon-
stration video.

For more details on any of
the gestures see the help
in the lower part of the
right menu window.

Figure2-4
Mouse Properties -
Device Settings

.|
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Disabling the Touchpad

If you need to disable the Touchpad for any reason (e.g. you may find that when us-
ing the computer’s internal keyboard you accidentally trigger the Touchpad when

resting your wrists or palmson it) you can do so by using Fn + F1 key combination.

Y ou can also set the system to automatically disable the internal Touchpad when an
external USB point device (e.g. aUSB mouse) is attached.

1.
2.
3.

Go to the Mouse Properties control panel.

Click to select Device Settings (tab).

Click to place a check in the “Disable internal pointing device when external
USB pointing device is attached” check box.

Click OK to save the setting.

Figure2-5
Mouse Properties
(Disable Touchpad)
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" PalmCheck
7@: The PalmCheck feature helps prevent operating the pad by accident, by recognizing
PalmCheck when your palm isresting on it or brushing its surface while you are typing.

In order to improve pad
scrolling responsive-
ness when using one-
finger scrolling, you can
adjust the PalmCheck
slider towards “Mini-

mum” as per your pref-
erence.

However bear in mind
that adjusting the slider
too far towards “Mini-
mum” can turn off Palm-
Check altogether.

Figure2-6
PalmCheck Slider
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Scrolling
The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the

Touchpad surface and slide both fingers in the direction required (in a straight con- Figure2-7
tinuous motion). Scrolling Gesture
4

Mouse Driver

If you are using an ex-
ternal mouse your op-

Zoomin erating system may be

. 9 . able to auto-configure
The Pinch Zoom gesture can be used to perform the same function as a scroll wheel your mouse during its
in Windows applications that support CTRL + scroll wheel zoom functionality. installation or only en-
Place two fingers on the Touchpad (for best results use the tips of the fingers) and able its basic functions.
slide them apart to zoom in, or closer together to zoom out. 25 SUTE i) ETEER in3

device’'s user docu-
mentation for details.

Figure2-8
Zooming Gesture
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Rotating

Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another
finger near the middle of the Touchpad and slide it in a circular motion around the
stationary finger (clockwise or counterclockwise) to rotate the object.

Figure2-9
Rotating Gesture

Three Finger-Flick/Three Fingers Down (Press)

The Three Finger-Flick gesture may be used to enhance navigation with avariety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-selectable applications.

Figure2-10
Flick/Press
Gesture

.|
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Audio Features

Y ou can configure the audio options on your computer from the Sound  control /

panel in Windows, or from the Realtek HD Audio Manager [ icon in the taskbar Volume Adjustment
notification area/control panel (right-click the taskbar notification areaicon fj to | The bsound V‘_"“mﬁ 'e"?'
bring up an audio menu). The volume may also be adjusted by means of the volume can e set using the vol

. . ) . K . j ume control in the Set-
icon in thetaskbar or theaudio dider in the Settings menu (see sidebar). tings menu in the

Charms Bar.

Right-click the icon i
to access the menu
above.

Figure2- 11
Realtek Audio
Manager
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5 Setup for Audio Recording
To record audio sources on your computer at optimum quality follow the instruc-

tions below:

1. Goto the Control Panel.

2. Click Realtek HD Audio Manager (Hardware and Sound), or right-click the
taskbar icon ﬂ and select Sound Manager.

3. Click Microphone Effects (tab) in Microphone (tab), and then click to select
Noise Suppression (button), or adjust the Recording Volume level to around 60,
to obtain the optimum recording quality.

4. Click OK to close the control panel and save the settings.

Figure2- 12
Realtek Audio
Manager -
Recording Setup
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Chapter 3. Power Management P
Overview OB Nwike

Power management
functions will vary slight-
ly depending on your

To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer

(the monitor and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is
¢ The Power Sources best to refer to the user’s

manual of your operat-

* Turning On the Computer :
ing system.

» Shutting the Computer Down (Note: Al pictures used
¢ Powc—_:r-qumg States on the following pages
» Configuring the Power Buttons are from the Windows
» Battery Information 8.1 0S.)
Power Options

The computer uses enhanced power saving techniques to give the operating system .
OS) direct control over the power and thermal states of devices and processors. For P [TEVEEEET T
( _ P s Processors. Windows is configured
example, this enables the OSto set devicesinto low-power states based on user set- | from Power Options

tings and information from applications. (Hardware and
Sound), which can be
accessed from the Con-
trol Panel (see page 1 -
16).

. |
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4

Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter

Useonly the AC/DC adapter that comeswith your computer. Thewrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-In jack on the right of the computer, connect
the AC power cord to the AC/DC adapter and then plug the AC power cord into an
outlet (make sure you use the adapter when first setting up the computer, as
to safeguard the computer during shipping the battery will be locked to not power
the system until first connected to the AC/DC adapter).

2. Raise the lid/LCD to a comfortable viewing angle.

3. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet isunavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely beforerecharging (see “ Battery FAQ” on page 3 - 19).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “ Battery Information” on page 3 - 14.
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Turning On the Computer

Now you are ready to begin using your computer. To turnit on simply pressthe pow-

er button on the front panel.
When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use

Power Options (Hardware and Sound) in the Windows control panel to configure
this feature.

4

Power Button as Stand by or Hibernate Button

You can use the OS's “Power Options” control panel to set the power button to send the
system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring
the Power Buttons” on page 3 - 9 for details).

Turning On the Computer 3 - 3
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Shutting the Computer Down

Note that you should always shut your computer down by choosing the Shut down

command asthiswill help prevent hard disk or system problems. Use the Shut down
or sign out item in the Context M enu (right-click the lower left corner of the screen
to bring up the menu).

Y ou can aso use the Power Menu in Settingsin the Windows 8.1 CharmsBar . If
you want to add Hibernate/Sleep to the Power Menu see “ Adding Hibernate/Sleep
to the Power Menu” on page 3 - 10.

Charms Bar Desktop App Start Screen

Figure3-1
Shut Down/Restart

3 - 4 Shutting the Computer Down
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Power Plans

The computer can be configured to conserve power by means of power plans. You

4

can use (or modify) an existing power plan, or create a new one. Resuming
Operation

The settings may be adjusted to set the display to turn off after a specified time, and

to send the computer into Sleep after a period of inactivity. <50 TEBEE = b o

page 3 - 11 for informa-

. . . . tion on how to resume
Click Change plan settings and then click Change advanced power settingstoac- | ('~ SRR

cess further configuration options in Advanced Settings. .

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure3-2

< > » Power Plan
Advanced Settings
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Figure3-3

Power Plans

Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. Thisisworth bearing in mind if you are experiencing
any reduced performance (especialy under DC/battery power).

Choose High perfor mance (you may need to click Show additional plansto view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Click to Show/Hide
additional
power plans
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Y ou can use power-saving states to stop the computer’ s operation and restart where
you left off. Win 8.1 uses the Sleep, Hibernate and Shut Down power-saving
states.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last | eft
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

To add Sleep to the Power Menu see “Adding Hibernate/Sleep to the Power
Menu” on page 3 - 10.

.|
Power-Saving States 3 - 7
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Wake On LAN

Support
(Windows 8)

Wake-On-LAN is only
supported from Sleep or
Hibernate states in
Windows 8.

If you require your com-
puter to wake up from
network activity in Win-
dows 8 then make sure
that the computer is ei-
ther in Sleep or Hiber-
nate.

Wake-On-LAN is not
supported from Shut-
down states in Win-
dows 8.
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Figure3-4
Power Menu

Hibernate

Hiber nate uses the least amount of power of al the power-saving states and saves
al of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last |eft off within seconds. Y ou should
put your mobile PC into Hiber nate if you will not use the computer for a period of
time, and will not have the chance to charge the battery. To add Hiber nate to the
Power Menu see “ Adding Hibernate/Sleep to the Power Menu” on page 3 - 10.

Shut down

Y ou should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hiber nate.

Sleep

Hibernate

Shut down

Restart

3 - 8 Power-Saving States



Power Management

Configuring the Power Buttons

The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the Z
computer in to a power-saving state. Click Choose what the power buttons do on Password
the left menu in Power Options to bring up the menu. Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure3-5
Power Options
Define Power
Buttons

.|
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Figure3-6
Power Options
Define Power
Buttons - Shutdown
Settings

Adding Hibernate/Sleep to the Power Menu
Add Hibernate/Slegp to the Power Menu as follows.

Go to the Power Options (Hardware and Sound) control panel.

Click Choose what the power buttons do.

Click “Change settings that are currently unavailable” @ change settings that ar= currently unsvsilsble .
Click to put a check in the Hibernate/Sleep box under Shutdown settings.

Click Save Changes and close the control panel.

agpNE
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Resuming Operation
Y ou can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F4 key combo).

Power Status Icon Color To Resume
Table3-1
Power Off Off Press the Power Button Resuming
Press the Power Button Operation
Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery)
Hibernate Press the Power Button
Orange (AC/DC adapter)
Display Turned Off Green Press a Key or Move the Mouse/Touchpad
Power Button 2
When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down Closing the Lid
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
R If you have chosen to
button for longer than this will force the computer to shut down).
send the computer to
Sleep when the lid is
closed, raising the lid

will wake the system up.

Configuring the Power Buttons 3 - 11
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Power Conservation Modes

g This system supports Energy Star power management features that place comput-
3 Power Conservation ers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period
Modes of inactivity. Adjust Power Conservation Modes from the Control Center:

The Energy Star setting
will result in maximum
power saving, but with
the possible loss of
some performance.

1. Pressthe Fn + Esc key combination to toggle the Control Center on/off.
2. Click either the Performance, Balanced or Energy Star button.

Setting the mode to Bal-
ance will give power
saving matched with
performance.

Performance will give
optimum computer per-
formance but with less
power conservation.

Note that the Energy
Star setting will put the
display into sleep after
no more than 15 min-
utes of user inactivity.

Figure3-7
Control Center
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Ctrl + Alt + Delete Key Combination

YoucanusetheCTRL + ALT + DEL key combination from almost any of the Win-

dows 8 interfaces/Appsto bring up afull-screen displaying L ock, Switch User, Log

off, Change a password and Task Manager options. If you click the Power icon
in the lower right corner of the screen a power management option menu appears to

display Sleep, Shut down, and Restart.

Figure3-8
Ctrl + Alt + Delete
Menu

To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to per-
form the function selected.

.|
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Battery Information

\N A/
LY Follow these simple guidelines to get the best use out of your battery.
Low Battery

Warning Battery Power

Whenihe bareryis oriti Y our computer’s bqttery power .is dependerjt upon many factors, includi ng the pro-
VA e @ grams you are running, and peripheral devices attached. You can set actions to be
ceueas GER Aehlel  taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
SCERERCEREEIE A power plan Change plan settings > Change advanced power settings (see Figure

or save your work, oth- ] i
erwise, the unsaved 3 -3 on page 3 - 6).

data will be lost when
the power is depleted.

Click the battery icon [ in the notification areato see the current battery level and
charge status.

Figure3-9
Battery Icon
(Notification Area) &
Battery Advanced
Settings

.|
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Removing the Battery

\ A/
We recommend that you do not remove the battery yourself. If you do need to re- ﬂ‘

move the battery for any reason (e.g. long term storage) see below. Bottom Cover
Removal Warning

1. Turn the computer off, and turn it over.

2. Slide the latch @ in the direction of the arrow. DY (e Eliby Co
3. Slide the latch @ in the direction of the arrow, and hold it in place. er(s) and /or screw(s) for
4. Slide the battery out in the direction of the arrow €. the purposes of device
. . upgrade as this may vio-
5. Reinsert the battery as illustrated below @. N i (02 (s @ e

6. Make sure the latches are returned to the lock position @. warranty.
If you need to replace/
e remove the hard disk/
9 0 RAM/optical device etc.,
for any reason, please

contact your distributor/
supplier for further infor-
mation.

Figure3- 10
9 Battery Removal
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Conserving Battery Power

4 » Useapower plan that conserves power (e.g Power saver), however note that
Windows Mobility this may have an affect on computer performance.
Center » Lower the brightness level of the LCD display. The system will decrease LCD
The Windows Mobility brightness slightly to save power when it is not powered by the AC/DC adapter.

Center control panel ) . .
provides an easy point | °* Reducethe amount of time before the display isturned off.
of access forinformation £ | ose wireless, Bluetooth, modem or communication applicationswhen they are

battery status, . .
ggns uesrgdsai; f,vi‘:;\gs; not being used (e.g. put the system in Airplane Mode).

device status etc.  Disconnect/remove any unnecessary external devices e.g. USB devices,
ExpressCards etc.
Figure3- 11
Windows Mobility
Center

.|
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Battery Life

Battery life may be shortened through improper maintenance. To optimize the life
and improveits performance, fully discharge and recharge the battery at least
once every 30 days. You can toggle battery charging on/off by using the Fn + 6
key combination.

New Battery

Always completely discharge, then fully charge, anew battery (see“ Battery FAQ”
on page 3 - 19 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hoursto fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery chargetimeisless. Refer to “LED Indica-
tors’ on page 1 - 7 for information on the battery charge status, and to “ Battery I n-
formation” on page 3 - 14 for more information on how to maintain and properly
recharge the battery pack.

.|
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Proper handling of the Battery Pack

ﬂ‘ * DO NOT disassemble the battery pack under any circumstances
Caution * DO NOT expose the battery to fire or high temperatures, it may explode
* DO NOT connect the metal terminals (+, -) to each other

S
Z

Damaged Battery Warning

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being

dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your distributor/supplier. If the battery has been dropped we
do not recommend using it any further, as even if the computer continues to work with a
damaged battery in place, it may cause circuit damage, which may possibly result in fire. It
is recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do | completely discharge the battery?

Use the computer with battery power until it shuts down due to alow battery. Don't

turn off the computer even if amessage indicates the battery iscritically low, just let
the computer use up al of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure3- 12
Power Plan Create

.|
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3. Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

Figure3- 13
Change Plan
Settings / Change
Advanced Power
Settings

S
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

Figure3- 14
Power Options
Advanced Settings -
Battery

* Low battery levels= 0%

» Critical battery Levels=1%

» Low battery action = Do Nothing

» Critical battery action (On battery) = Shut Down
 Critical battery action (Plugged in) = Do Nothing

.|
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How do | fully chargethe battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.
How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
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Drivers & Utilities (Win 8.1)

Chapter 4: Drivers & Utilities (Win 8.1)

This chapter dealswith installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware componentsfor which the latest versions of most available op-
erating systems haven't built in drivers and utilities. Thus, some of the system com-
ponents won't be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities.

What to Install

The Device Drivers & Utilities+ User’sManual disc containsthe drivers and util-
ities necessary for the proper operation of the computer. Table4 - 1, on page4 - 4
listswhat you need toinstall and it isvery important that thedriversareinstalled
by the method outlined in this chapter, and in the order indicated.

Note that the information included on the following pages is for Windows 8.1 only.
See“Drivers & Utilities (Windows 7)” on page E - 8 for information on drivers and
utilities for the Windows 7 (64-bit with Service Pack 1) operating system. For Win-
dows 10 driver installation see “ Windows 10" on page F - 1.

Module Driver Installation

The proceduresfor installing driversfor the WirelessL AN and Combination Blue-
tooth & WLAN modules are provided in “Modules & Options” on page 6 - 1.

What to Install 4 - 1

\ 7/
L&
Driver Installation &
Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).




Drivers & Utilities (Win 8.1)

Driver Installation

Insert the Device Drivers & Utilities + User’s Manual disc into the computer’s DVD drive.
Click the message “Tap to choose what happens with this disc.”

Click Run autorun.exe.
Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

PN

Figure 4 - 1- Drivers Installer Screen 1

. |
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5. Check the driver installation order from Table 4 - 1, on page 4 - 4 (the drivers must be installed in this order)
which is the same as that listed in the Drivers Installer menu below.

Click to select the driver you wish to install, (you should note down the drivers as you install them).

7. Follow the instructions for each individual driver installation procedure as listed on the following pages.

o

Figure4 - 2 - Install Drivers

Driver Installation 4 - 3
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Win 8.1 Driver - System Required Page # Win 8.1 Driver (Other / Options) Page #
Chipset Page 4 -7 PC Camera Module (No driver required) Page 6 - 2
Video (VGA) Page 4 -7 Wireless LAN Module Page 6 - 11
LAN Page 4 -7 Bluetooth & WLAN Combo Module Page 6 - 16
CardReader Page 4 -7 Intel® Rapid Storage Technology Page 6 - 21
Touchpad Page 4 -7 Trusted Platform Module Page 6 - 22
Hot Key Page 4 - 8 3G/4G Module (No driver required) Page 6 - 28
Airplane Page 4 - 8 Wireless Display (No driver required) Page 6 - 34
MEI Driver Page 4 -8
Audio Page 4 -8

Table 4 - 1- Driver Installation

All drivers provided are for Windows 8.1 (64-hit).
Notethat you need toinstall both the WLAN & Bluetooth driversfor the WLAN & Bluetooth Combo modules.

. |
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Manual Driver Installation

Click Browse CD/DVD (button) inthe Driversinstall-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable
Windows Updatein order to get all the latest security
updatesetc. (all updateswill includethelatest hotfixes
from Microsoft). See “Windows Update” on page 4 -
9 for instructions.

Drivers & Utilities (Win 8.1)

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if itisnot listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Go tothe Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Devices and Printers > Device
Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.

Driver Installation 4 - 5
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User Account Control

If aUser Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow theinstallation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

Y ou will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found

If you see the message “New Har dwar e Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.

4

Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 6 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Make sure any modules (e.g. WLAN or Bluetooth) are
ON before installing the appropriate driver.

4 - 6 Driver Installation



Driver Installation Procedure

Insert the Device Drivers & Utilities+ User’s Manual
disc and click Install Drivers (button).

Chipset

Click 1L.Install Chipset Driver > Yes.

Click Next.

Click the Accept button to agree to the license.
Click Install.

Click Finish.

arONPE

Video (VGA)

1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Note: After installing the video driver go to the Dis-
play/Display Settings control panel to adjust the vid-
€0 Settings to the highest resolution.

Drivers & Utilities (Win 8.1)

LAN

Note: If the computer enters a deep sleep mode during
installation, you will be prompted to plug in a network
cable, and click OK, to continue installation. If a net-
work cable is not available, restart the system and re-
install the LAN driver.

1. Click 3.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.

CardReader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad

1. Click 5.Install Touchpad Driver > Yes.

2. Click Next.

3. Click the button to accept the license agreement
and click Next.

4. Click Finish > Restart Now to restart the com-
puter.

Driver Installation 4 - 7
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Hot Key
1. Click 6.Install Hotkey AP > Yes.
2. Click Next.

3. Click Finish to restart the computer.

Airplane

Note: Do not use Update Driver in Device Manager to
install the Airplane Mode driver.

1. Click 7.Install Airplane Driver > Yes.

2. Click Next.

3. Click Finish to restart the computer.

MEI Driver

1. Click 8.Install MEI Driver > Yes.

2. Click Next.

3. Click the check box to accept the license and
then click Next.

Click Next.

5. Click Finish.

E

Audio

1. Click 9.Install Audio Driver > Yes.
2. Click Next.

3. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, gject
the Device Drivers & Utilities + User’s Manual disc
and thenreinsert it (or double-click thedisciconinMy
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.
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Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft). To enable Windows Update make
sure you are connected to the internet:

1.
2.

3.

Go to the Control Panel.

Click Windows Update (System and Security/
Security).

Click Check for updates (button).

The computer will now check for updates (you need
to be connected to the internet).

Click Install now (button) to begin checking for the
updates.

Click Install updates (button) to install the updates.

Drivers & Utilities (Win 8.1)

Optional Drivers

See the pages indicated for the driver installation pro-
ceduresfor any modulesincluded in your purchase op-
tion.

Figure 4 - 3 - Drivers Installer (Options)

Note that you need to install both the WLAN & Blue-
tooth drivers for the WLAN & Bluetooth Combo
modules.

Driver Installation 4 - 9
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Chapter 5: BIOS Utilities "

Overview BIOS Screens

This chapter gives a brief introduction to the computer’ s built-in software: i e e B
screens  pictured on

. these pages are intend-
If your computer has never been set up, or you are making important changesto the BESEERIREREE IRE

system (e.g. hard disk setup), then you should review this chapter first and note the B FSEeNIE S R
original settings found in Setup. Even if you are abeginner, keep arecord of the set-  JHEISES
tings you find and any changes you make. This information could be useful if your

- BIOS versions are sub-
system ever needs servicing. ject to constant change

and revision, therefore
Thereis one general rule: Don’t make any changes unless you are sure of what you VSISl lE]

. . . : screens may appear
aredoing. Many of the settings are required by the system, and changing them could slightly _ different _from

cause it to become unstable or worse. If you have any doubts, consult your service  BEFSEE IS T
representative. pages.

. |
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BIOS Settings
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Opti-
mized Defaults with
<F3>.

UEFI Boot & POST

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.

The Setup Utility

Each time you turn on the computer the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

Asthe POST proceeds, the computer will tell you if thereisanything wrong. If there
isaproblem that prevents the system from booting, it will display asystem summary
and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can't get into Setup without rebooting.

The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

To enter Setup, turn on the computer and press F2 (give the system a few seconds
to enter Setup). If the Boot L ogo is enabled the F2 on screen will be highlighted to
illustrate that the system is processing the request during the POST (or press F7 for
boot options). If you get a*“Keyboard Error”, (usually because you pressed F2 too
quickly) just press F2 again.

If the computer is aready on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7 and choose your preferred boot device.

5 - 2 The Setup Utility
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Failing the POST
Errors can be detected during the POST . There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
distributor/supplier as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot
options.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.
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4

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer's menus will
indicate the configura-
tion appropriate for your
model and options.

Figure5-1
Navigation Menu

Setup Screens

The following pages contain additional advice on portions of the Setup. Along the
top of the screen is a menu bar with menu headings. When you select a heading, a
new screen appears. Scroll through the features listed on each screen to make chang-
esto Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

If these tools are confusing, press F1 to call up aGeneral Help screen, and then use
the arrow keysto scroll up or down the page.

Theltem Specific Help onthe upper right side of each screen explainsthe highlight-
ed item and has useful messages about its options.

If you see an arrow p next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.
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Main Menu

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

System Date

Figure5-2
Main Menu

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settingsin your operating system, you will aso change
these settings. Some applications may also alter data files to reflect these changes.

Main Menu 5 - 5
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SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Ports.

OffBoard SATA Controller Configuration (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of any devices on the
off board SATA Controller if applicable.

CPU/ ME FW Version / Systery Extended Memory: (Main Menu)
Thisitem contains information on the CPU type and system memory, and is not user
configurable. The system will auto detect the amount of memory installed.

MB Series/ BIOS Revision / KBC/EC firmware Revision
This item contains information on the BIOS version etc., and is not user configu-
rable.
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Advanced Menu

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

Figure5- 3

SATA Mode: [RHCT Mode] Advanced Menu

SATA Mode (Advanced Menu)
The SATA (Serial ATA) control is configured to operatein AHCI (Advanced Host

Controller Interface) mode.

. |
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4

UEFI Boot

When UEFI Boot is ena-
bled, then the prompts
to press F2 or F7 will not
appear. However you
can still press F2 to en-
ter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.

Boot Logo (Advanced Menu)

Use this menu item to enable/disable the Boot L ogo screen at system startup if you
have not enabled UEFI Boot. If you disable the Boot L ogo you will not see the F2
Enter Setup or F7 Boot Options prompts on the screen, however you can still press
these keys, while the boot screen is displayed, to perform the Enter Setup or Boot
Option functions.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
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Security Menu

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

4

Security Menu

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Secure Boot Mode [Standard]

Secure Boot Mode
standard
Custom

Figure5-4
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility).
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N2
2

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled), NEVER
forget your password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Set User Password (Security Menu)

Y ou can set a password for user mode access to the Aptio Setup Utility. Thiswill
not affect access to the computer OS, (only the Setup utility) unless you choose to
set a Password on Boot (see below). Many menu items in the Aptio Setup Utility
cannot be modified in user mode.

Note: You can only set the user password after you have set the supervisor pass-
word.

Password on boot: (Security Menu)

Specify whether or not apassword should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is“ Disabled”.

.|
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Secure Boot (Security Menu)

Secure Boot prevents unauthorized operating systems and software from loading
during the startup process. Secure Boot is available as a menu option if you have
enabled UEFI Boot (see“ UEFI Boot (Boot Menu)” on page 5 - 14). Enabling Se-
cure Boot will bring up the Secur e Boot M ode menu to enable you to configure Se-
cure Boot as Standard (with afixed secure boot policy) or Custom (which enables
you to make changes to the Key M anagement database).
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Figure5-5
Security Device
Support

TPM Configuration (Security Menu)

This sub-menu will allow you to enable/disable Trusted Platform Module (TPM)
support, and to configure the TPM State. Select TPM Configuration and press En-
ter to access the sub-menu. Press Enter to accessthe Security Device Support menu
and select Enable to support TPM (see “ Trusted Platform Module” on page 6 - 22
for details).

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

Security Device Support [Enable]

5 - 12 Security Menu
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Boot Menu

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

oot .
- Figure5-6
Boot Menu

Boot Option #1 [Windows Boot Manager]

SN
ALK

BIOS Screens

Note that the BIOS
screens  pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore

S . your computer's actual
When you turn the computer on it will look for an operating system (e.g. Windows TS TR Cpeey

7) from the devices listed in this menu, and in this priority order. If it cannot find ~ EESFRRIENHAEAEE T
the operating system on that device, it will try to load it from the next device in the B GEEETREEL R NG
order specified in the Boot Option Priorities. Item specific help on the right is §EEESE

available to help you move devices up and down the order.
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Boot Option Priorities (Boot Menu)

Press Enter to access the menu, use the arrow keys to move up and down the menu,
and press Enter to select a device from the Boot Option # list (the selected device
will be highlighted in white).

UEFI Boot (Boot Menu)

Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Inter-
face (UEFI) specification provides a clean interface between operating systems and
platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard
boot and runtime services. The Network Stack and Launch CSM (Compatibility
Support Module - for legacy BIOS compatibility) items will be enabled as options
under UEFI Boot.
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Save & Exit Menu

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

Figure5-7
Save & Exit Menu

Save & Exit

Save Changes and Reset

Click Save Changes and Reset to save al changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. Y ou can also choose to restore the original Setup defaults that will re-
turn the Setup to itsoriginal state, and erase any previous changes you have madein
aprevious session.

Save & Exit Menu 5 - 15
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Y/

\§

Chapter 6: Modules & Options %

i Wireless Device
OverVIGW Operation Aboard
This chapter contains information on the following modules, which may come with Aircraft
your computer, depending on the configuration purchased. If you are unsure please RS TEEA T
contact your service representative. electronic transmission

devices aboard aircraft
* PC CameraModule * Trusted Platform Module is usually prohibited.

* WirelessLAN Module + 3G/4G Module Make sure the WLAN,
 Bluetooth & WLAN Combo Module « Wireless Display Bluetooth and 3G/4G
* Intel® Rapid Storage Technology modules) are OFF (or

the system is in Air-

Note that the information included on the following pages is for Windows 8.1 only. E's?:ge Mtc;]dee) iigr?]‘;u"’:;?

See* Drivers & Utilities (Windows 7)" on page E - 8 for information on driversand ISR I F A SRS
utilities for the Windows 7 (64-bit with Service Pack 1) operating system. For Win-
dows 10 driver installation see * Windows 10" on page F - 1. )

. |
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PC Camera Module

When the PC Camera application is run the LED indicator to the left of the camera
will beilluminated (see @ Figure1- 2 on page 1 - 6). Note that you need to use the
Cameraapp in Windows 8 to take pictures and capture video. Usethe Fn + F10 key
combination (see“Function/Hot Key Indicators’ on page 1 - 10) to toggle power

to the PC Camera module.

6 - 2 PC Camera Module



PC Camera Audio Setup

If you want to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1.
2.
3.

Go to the Control Panel.

Click Sound (Hardware and Sound) and click Recording (tab).
Right-click hold and release Microphone (Realtek High Definition Audio) and
make sure the item is not disabled.

Double-click Microphone (or select Properties from the right-click menu).

Modules & Options

Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to

the level required.
Click OK and close the control panels.

Right-click

Figure6-1
Audio Setup for PC
Camera
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Camera App

1. Runthe Camera app from the Start screen by clicking on the Camera app icon

Figure6- 2 2. The camera interface will display two buttons on the right side of the screen.

Camera App
Buttons

4

Exposure

Use the slider to adjust
the Exposure level.

3. The upper button is used to record video, and the lower button is used
to take still pictures.

4. Right-click on the screen to bring up menu buttons at the bottom of the screen.
5. These buttons enable you to access the camera roll (where captured pictures and
video are displayed), set the timer (the time period before capture begins; 3
seconds, 10 seconds or Off) and set the exposure level using the slider to obtain
the best results.
Camera Options

Camera roll Timer Exposure

6 - 4 PC Camera Module
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Camera Options
The Camera Options settings may be accessed as follows:

1.

2.

Run the Camera app from the Start screen by clicking on the Camera app icon

While the camera app is running access the Charms Bar (e.g. click Use the
Windows logo key == + C key combination).

Click Settings and then click Options.

You can adjust the Photo Aspect Ratio, select the Microphone, Hide/Show grid
lines and turn Location Info on or off from the Options panel.

Figure6- 4
Camera Options

PC Camera Module 6 - 5
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Taking Pictures/Capturing Video
1. Runthe Camera app from the Start screen by clicking on the Camera app icon

2. Right-click the screen and select the timer if you require a countdown before
capture.

3. Click the appropriate icon to take a picture or start video capture (if video capture

begins a timer will appear in the bottom corner of the screen).

To stop video capture click the main window again (or click the stop icon ).

Captured photos and videos will be saved to a Camera Roll folder within the

Pictures folder.

ok

Figure6-5
Pictures - Camera
Roll
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Camera Roll

1. Runthe Camera app from the Start screen by clicking on the Camera app icon
2. Right-click on the screen to bring up menu buttons at the bottom of the screen.
3. Click Camera Roll.

4. Click the arrows - / -(on either side of the screen) to browse through the

captured photos/video, and back to the Camera app.

Editing Photos

1.

e

©No O

PC Camera Module 6 - 7

Clicking on a captured photo will bring up an app bar with a series of buttons. Figure6 - 6

Edit Buttons
(for Still Photos)

The Camera button will take you back to the home screen of the camera app.
Click Delete to remove any photo from the camera roll (you will be asked to click
Delete again to confirm the deletion).

The Open With button will allow you to select a program with which to open the
photo.

You can click Set as Lock screen to set the photo as the lock screen picture.
Clicking Slide Show will create a slide show of photos/video in the camera roll.
Click Rotate to rotate the picture through 90 degrees.

Use the handles to Crop any captured picture, and click Apply to make the
changes (you can change the Aspect ratio by clicking the button and selecting an
aspect ratio from the menu). You can Save a copy (create another copy of the
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9.
10
Figure6-7
Editing Tools
11.

6 - 8 PC Camera Module

photo with the edited changes), Update original (which changes the original
picture permanently) or Undo any changes.
Click the Edit button to bring up a full suite of tools to edit the photo.

. Click on the menu headings on the left, and then click on the tool on the right to

edit the photo as required.
Edit Menu Basic Fixes Light Color  Effects

203

Temperature

Q

Rotate

Saturation

Q

Color enhance

Retouch

After the editing process is completed right-click on the photo to Save a copy
(create another copy of the photo with the edited changes), Update original

(which changes the original picture permanently), Undo any changes or Cancel
the editing.
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Editing Photos
1. Clicking on a captured video will bring up an app bar with a series of buttons.

Figure6- 8
Edit Buttons
Trim (for Video)

2. Click Delete to remove any video from the camera roll (you will be asked to click
Delete again to confirm the deletion).

3. The Open With button will allow you to select a program with which to run the

Video.

Clicking Slide Show will create a slide show of photos/video in the camera roll.

5. Click Trim to edit the video. Use the round buttons at either end of the slider to
adjust the video length and click Save a copy to save the changes made.

»

Figure6-9
Trim Video
(for Video Files)
Click to select and move therounded buttonsto edit the video.

PC Camera Module 6 - 9
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Video File Size

Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (goto My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to aremovable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows 8.1 system requires a minimum of 16GB (32-bit) or 20GB
(64-bit) of free space on the C: drive system partition. In order to prevent system
problems it is recommended that you move any large sized captured video fileto a
location other than the C: drive.

6 - 10 PC Camera Module
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Wireless LAN Module

If you haveincluded an Intel® or 3rd Party WL AN modulein your purchase option N
mak_e sure tha_t the module ison (i.e. the system is not in Air plane M ode) before in- Operation Aboard
stalling the driver. Aircraft

2N\Z
Z

Make sure you install the driversin the order indicated in Table 4 - 1, on page 4 - 4. The use of any portable
electronic transmission
Note that you need to install both the WLAN & Bluetooth drivers for the WLAN idsev'ﬁiﬁ aﬁgoa;?oﬁgﬁgﬁ
& Bluetooth Combo modules. Make sure the WLAN,
Bluetooth and 3G/4G
modules) are OFF (or
the system is in Air-
plane Mode) if you are
using the computer
aboard aircraft (see

).

Wireless LAN Module 6 - 11
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3rd Party 802.11b/g/n Driver Installation

1. Makesurethemoduleison and the system isnot in Airplane Mode,
and then insert the Device Drivers & Utilities+ User’s Manual discinto an
attached DVD drive.

Click Option Drivers (button).

Click 1L.Install WLAN Driver > Yes,

Click Next.

Click Finish to restart the computer.

The operating system is the default setting for Wireless LAN control in
Windows (see page 6 - 13).

ok wN

Intel® WLAN Driver Installation

1. Makesurethemoduleison and the system isnot in Airplane Mode,

and then insert the Device Drivers & Utilities+ User’s Manual discinto an

attached DVD drive.

Click Option Drivers (button).

Click 1L.Install WLAN Driver > Yes.

ICIis(t:gliln the check box to agree to the End User License Agreement and click
nstall.

Click Finish.

The operating system is the default setting for Wireless LAN control in

Windows (see page 6 - 13).

o0 WD

. |
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WLAN Configuration in Windows

Y ou can configure a wireless connection using one of the following options, how-
ever make sure the Wireless LAN module is turned on (and not in Airplane Mode)
before configuration begins.

Charms Bar
1. Go tothe Charms Bar.

2. Select Settings and then click the WiFi icon (it should read Available under the
icon and Airplane mode should be Off).
3. Alist of available access points will appear.

(© Networks
l") Airplane mode
) oft Figure6 - 10
Available 67 Brightness WiFi Settings
(Charms Bar) &
Networks

On

2 ¢

Motifications Power Keyboard

.IIII CPhone

al RD113-A5US-RTe6U-2....

al RDT13
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Double-click an access point to connect to it (or click it and click Connect).

Enter a network security key (password) if required, and click Next.

You can choose to find other devices or not.

When you are connected to the network access point it will display Connected

[ Connected |

8. Select any connected network and click Disconnect to disconnect from a
connected access point.

No A

(© Networks (© Networks

Airplane mode Airplane mode

Off

Figure6- 11
Networks
Connected /
Disconnect

On

.I“l CPhone

RD113-ASUS-RTE6U-2....
all

all RD113

9. You can click the Airplane Mode button to turn the mode (including Bluetooth) On
or Off.
10. Alternatively you can click the WiFi button to turn just the WiFi On or Off.
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Desktop Mode

1.

Noogkwd

Switch to the Windows Desktop (click the app or use the Windows logo key == +
D key combination).

Click the wireless icon [l in the notification area of the taskbar.

A list of available access points will appear.

Double-click an access point to connect to it (or click it and click Connect).

Enter a network security key (password) if required, and click Next.

You can choose to find other devices or not.

Select any connected network and click Disconnect to disconnect from a
connected access point.

(© Networks

Airplane mode

(© Networks off Figure6 - 12
Windows Desktop
Airplane mode Taskbar Notification
on Area WLAN
Connection

.|||| CPhone

RD113-ASUS-RT66U-2....
all

| RD113

Wireless LAN Module 6 - 15



Modules & Options
Bluetooth & WLAN Combo Module

If your purchase option includes the Combination Wireless LAN & Bluetooth
module (either Intel® or 3rd Party) then install the driver as instructed overleaf.

MN\Z
2§
Wireless Device

Operation Aboard

Alfcrat Make sure that the moduleis on (i.e. the system is not in Airplane M ode) beforein-

The use of any portable stalling the driver.
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the WLAN,
Bluetooth and 3G/4G
modules) are OFF (or
the system is in Air-
plane Mode) if you are
using the computer
aboard aircraft (see

4

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported

in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.

).
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3rd Party Bluetooth (V4.0) Combo Driver Installation

1.

OO0k wWN

Make surethe moduleison and the system isnot in Airplane Mode,
and then insert the Device Drivers & Utilities + User’s Manual disc into an
attached DVD drive.

Click Option Drivers (button).

Click 2.Install Combo BT Driver > Yes.

Click Next.

Click Finish to restart the computer.

See “Bluetooth Configuration in Windows” on page 6 - 18 for configura-
tion instructions.

Intel Bluetooth Combo Driver Installation

1.

ONOoOAWN

Bluetooth & WLAN Combo Module 6 - 17

Make surethe moduleison and the system isnot in Airplane Mode,
and then insert the Device Drivers & Utilities + User’s Manual disc into an
attached DVD drive.

Click Option Drivers (button).

Click 2.Install Combo BT Driver > Yes.

Click Next > Next.

Click in the check box to accept the license and click Next.

Click Next > Finish.

Click Yesto restart the computer.

See “ Bluetooth Configuration in Windows’ on page 6 - 18 for configura-
tion instructions.

Modules & Options

4

High Speed Bluetooth
Data Transfer

The Combination Wire-
less LAN & Bluetooth
module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.

Check your Bluetooth
compatible device’'s doc-
umentation to confirm it
supports high speed data
transfer.
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Bluetooth Configuration in Windows

N\ A/

7£l< Y ou can configure a Bluetooth connection as below, however make sure the Blue-

Bluetooth Headset tooth moduleis on (or the system is not in Airplane Mode) before configuration.
Stereo Setup

Desktop Mode
To setup a Bluetooth 1. Switch to the Windows Desktop (click the App or use the Windows logo key 2@ +
headset to support ste- D key combination).
reo audio see page 2. Click the notification area of the taskbar and double-click the Bluetooth icon [g3§ (or
: click and select Show Bluetooth Devices).
3. The Bluetooth item in PC and Devices will appear.
OR
Charms Bar
1. Go tothe Charms Bar.
2. Select Settings and then click Change PC Settings.
3. Select the Bluetooth item in PC and Devices.

Figure 6 - 13 O E 0:

Bluetooth Taskbar Available Brightness
Icon & Change PC
Settings (Charms =]

Bar -Settings) Notifications Keybaard

‘ \ Change PC settings
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4. Make sure that Bluetooth is turned on and a list of discovered devices will appear.

5. Double-click the device you want to pair with the computer and click Pair.
Figure6- 14

PC and Devices -
Bluetooth
6. On first connection the computer will provide you with a pairing code to be entered
onto the device.

Figure6 - 15

Enter the Passcode

7. Enter the code into your Bluetooth enabled device and click Yes on the computer
to complete the pairing.
8. Select a device and click Remove Device to disconnect from any device.
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To Make your Computer Discoverable to Bluetooth Devices

1. Switch to the Windows Desktop (click the app or use the Windows logo key == +
D key combination).

2. Click the notification area of the taskbar, click the Bluetooth icon and click
Open Settings.

3. Click Options, and make sure that Allow Bluetooth devices to find this
computer check box (Discovery) has a check inside it.

4. Make sure that the Alert me when a new Bluetooth device wants to connect
check box (Connections) has a check inside it, if you want to be notified when a
Bluetooth device wants to connect.

Figure6 - 16
Bluetooth Settings

. |
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Intel® Rapid Storage Technology ¢

Install the Intel® Rapid Storage Technology to support your AHCI mode SATA =

drive IRST and M.2 PCl-e
: SSDs

IRST Driver Installation 2'?5252“ '”;ee'gmzﬁ)p;g

1. Insertthe Device Drivers & Utilities + User’s Manual disc into an attached  BCRESE S S e e V1
DVD drive. SSDs with a PCl-e In-
Click Option Drivers (button). UEIECEE (2 SIS e Tl
Click 3.Ingtall IRST Driver > Yes. e
Click Next. S

Click in the check box to accept the license and click Next.

Click Next > Next > Next.

Click Finish to restart the computer.

Run the Intel® Rapid Storage Technology app from the Apps screen.

N>R~ WN
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Trusted Platform Module

(Optional)

The TPM security chip allowsyou to create and manage digital certificatesfor user
and platform authentication. This type of security is usually administered within
large enterprises and organizations, and therefore requires implementation by a sys-
tem administrator before users can access security features.

Individual users can use the TPM as an authentication with the fingerprint reader.

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection. In addition M ake sure you prepare
aremovablemedia (e.g. aUSB flash drive) to store passwor dsetc. befor e begin-
ning the TPM initialization process.

Before setting up the TPM functions you must initialize the security platform.

6 - 22 Trusted Platform Module
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Enabling & Managing TPM

Restart the computer.

Enter the Aptio Setup Utility pressing F2 during the POST/startup.

Use the arrow keys to select the Security menu.

Select TPM Configuration and press Enter to access the sub-menu.

Press Enter to access the Security Device Support menu and select Enable.
Press F4 to save the changes and restart the computer.

You can now manage the TPM from Windows.

Nog,rwdhE

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

Security Device Support [Enable]

Figure6 - 17
Security Device
Support (Enabled)

. |
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TPM Management in Windows
Y ou can manage your TPM settings from within Windows:

1. Gotothe Control Panel.
2. Click BitLocker Drive Encryption (System and Security).
3. Click TPM Administration.

b Figure6- 18

BitLocker Drive
Encryption
(TPM
Administration)

O
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4. The TPM Management window allows you to configure the TPM within Windows.
As TPM is usually administered within large enterprises and organizations, your
system administrator will need to assist you in managing the information here.

Figure6- 19 a

Trusted Platform
Module (TPM)
Management on
Local Computer
Administration
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TPM Actions

1. Click Prepare the TPM and follow the instructions in the Wizard to prepare the
TPM (this will probably require a restart of the computer and confirmation of the
setting changes after restart by pressing the appropriate F key).

2. After the restart the TPM will be prepared and you can then use the Actions menu
to Turn TPM off, Change Owner Password, Clear TPM or Reset TPM Lockout.

3. A wizard will help take you through any setup steps.

Figure6 - 20
TPM Actions Menu

. |
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BitLocker

BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt
data on the disk. Access the Microsoft BitL ocker Drive Encryption control panel
applet from the Windows control panel (System and Security).

1. Click Turn on Bit Locker.
2. Follow the on-screen instructions to setup BitLocker, and make sure you have a
removable media (e.g. a USB flash drive) to store saved recovery keys etc.

Figure6 - 21
BitLocker Drive
Encryption

. |
Trusted Platform Module 6 - 27




Modules & Options

’ 3G/4G Module

SN
ﬂ\ If you haveincluded an optional UM T S/HSPA+ based 3G Module (Universal Mo-

nggfiﬁzi E,ii\ngd bile Telecommunications System or High Speed Packet Access) module or LTE

Aircraft (Long Term Evolution) 4G module (see “ Communication” on page D - 3 for spec-
The use of any portable !flcat|on. details) in your purchase option, you do.not require a drlver/appllcatl on
e ! installation for Windows 8.1. Follow the instructions overleaf to install the USIM
e etk -1 @ card (which will be provided by your service provider), and then use the Charms
S CELEER el BIECEE Bar Wirelessicon to accessthe 3G/4G network in the same manner asthe WLAN

Make sure the WLAN, (see page6- 31)_
Bluetooth and 3G/4G

module(s) are OFF (or
the system is in Air-
plane Mode) if you are
using the computer
aboard aircraft (see

S
Z

Important Notice

If your purchase option includes both Wireless LAN and 3G/4G modules, then the appro-
priate antennas will be installed. Note that In order to comply with FCC RF exposure com-
pliance requirements, the antenna must not be co-located or operate in conjunction with
any other antenna or transmitter.

Important Notice - 3G/4G & Bluetooth/Wireless LAN Modules

).

In order to comply with FCC regulations you should NOT operate the 3G/4G module and
the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency,
and cause interference. When the 3G/4G module is powered on, make sure that the Blue-
tooth/Wireless LAN modules are powered off.
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3G/4G Module USIM Card Installation

\ A/
Follow the instructions below to install the USIM card (which will be provided by L&
your service provider). Power Safety
1. Turn the computer off, and turn it over. Warning
2. Slide the latch @ in the direction of the arrow. Before you undertake any
3. Slide the latch @ in the direction of the arrow, and hold it in place. installation procedures,
4. Slide the battery out in the direction of the arrow @). mEl® SURE HEL BU [IEE

turned off the power, and
disconnected all peripher-

als and cables (including
telephone lines).

o 9 USIM Card Orientation

Note that the USIM card’s
readable side (with the
gold-colored contacts)
should face upwards as il-
lustrated.

Figure6 - 22
Battery Removal
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5. Insert the USIM card 9 as illustrated below until it clicks fully into position, and
replace the battery.
6. Press the USIM card to eject and remove it @.

\ A/
ALK
USIM Card Ejection

Simply press on the USIM
card to eject it, however do
not do this while a connec-
Figure6 - 23 tion is in progress. If you
USIM Card Insertion do eject the card while a
3G/4G connection is on-
going, you will need to
6 shut down the system, re-
insert the USIM card, re-
start the system and then
reestablish the 3G/4G
connection.

If you wish to change
USIM cards then you will
need to shut the system
down, reinsert the USIM
card, restart the system
and then reestablish the
3G/4G connection.
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3G/4G Configuration in Windows

\ A/
Y ou can configure a 3G/4G connection as below, however make sure the system is 2§
not in Airplane Mode before configuration begins. 3G/4G Module PIN
Code & Power-Saving
Charms Bar
1. Go tothe Charms Bar. Note that there may be
2. Select Settings and then click the WiFi icon (it should read Available under the some issues when a/4G
icon and Airplane mode should be Off). PIN Code is set for 3G
3. Alist of available access points will appear under Mobile Broadband. modules in Windows, if

Mobile Broadband has

been turned off, and the
system has resumed
from a power-saving

A ) 0 ‘,

state. See

Available 67 Brightness

2 O

Notifications Power Keyboard

Figure6 - 24

Change PC settings Networks

\ Mobile Broadband

3G/4G Module 6 - 31



Modules & Options

4. Any 3G/4G service provider (connection information is usually stored on the USIM
card) will appear under Mobile Broadband.

5. Double-click any connection icon under Mobile Broadband (or click and then click
Connect).

Figure6 - 25
Mobile Broadband

b (Connect)

6. The system will connect to your network.
7. A Connected will appear alongside the 3G/4G connection (click the connection to
view the timer which indicates your connected time for the current session).
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8. You can then access the internet, download e-mail etc. as per any internet -
connection. ﬂ(

9. To disconnect you can select the connection and click Disconnect [EZea]. Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.

Make sure the system is
in Airplane Mode if you
are using the computer
aboard aircraft.

Figure 6 - 26
10. You need to either use Airplane Mode, or to turn the Mobile Broadband module Mobile Broadband
off aboard aircratft. (Disconnect)
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4

Compatible
Adapters

For a list of compatible
display and audio adapt-
ers check the Intel web-
site, or your distributor/
supplier.

Wireless Display

Wireless Display (Miracast) uses your WirelessLAN or WirelessLAN & Blue-
tooth Combo module (you need to make sure that your video adapter/display de-
vice is compatible with your particular WLAN/Combo modul€) in conjunction with
a compatible video adapter/display device (purchased separately) to alow you to
display the contents of the notebook display on another display (e.g. HDTV), with-
out the need to have cables stretching across aroom.

Y ou can use the wireless display to play games, browse the internet, display videos
or photo slide shows on your TV/external display without using HDMI or A/V ca-
bles.

Before configuring Wireless Display you will need to set up your compatible
adapter with your display/speakers. Connect the adapter using an HDMI or A/V ca
ble and turn on the display (or in the case of speakers connect them to the wireless
speaker adapter with the cables provided with the adapter), and then set the display
to the appropriate input channel (see the documentation supplied with your compat-
ible adapter/display for full details).

Note that no driver or application is required for wireless display in Windows 8.1.
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Wireless Display Configuration

Note that no driver or application is required for wireless display in Windows 8.1.
Go the Charms Bar, select Devices.

Click Project.

Click Add a wireless display.

pPoNE

Figure6 - 27
Add a Wireless
Display
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5. The system will then search for compatible display devices (this may take up to
60 seconds so allow time for this to complete).

Figure6 - 28
Searching For
Devices J

6. Double-click any detected display device in the list.
7. You may then need to input a pin number for the device to which you are

connecting.
8. Click Next.

Figure6 - 29
Enter PIN

.|
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9. The display will then connect (for specific settings for your display see the
documentation supplied with your compatible adapter/display for full details).

10. To disconnect from the display you can select it in PC and Devices > Devices and
click Remove Device > Yes; or go to the Project menu (Charms Bar > Devices)
and click Disconnect.

O

Figure6 - 30

Remove Device/

o Disconnect

Remove device
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Troubleshooting

Chapter 7: Troubleshooting

Overview

Should you have any problemswith your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’'t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautionsin the preface.
If al elsefails, talk to your service representative. Y ou should also make a record of what happened and what
remedies you tried.

Of course, if something goeswrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you' ve tried everything, and the system still won't cooperate, try turning it off
for afew minutes and then rebooting. Y ou will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
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Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Isthe computer actually plugged into aworking electrical outlet? If plugged into apower strip,
make sureit is actually working. Check the LED Power & Communication I ndicator s (see* System Map:
LCD Panel Open” on page 1 - 6) to see the computer’s power status.

Connections - Check al the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hiber nate or Sleep mode by pressing the keys config-
ured in your Power Options (see “ Power-Saving States” on page 3 - 7), the Fn + F4 key combination, or
power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness.

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB storage devicesin any connected drive.

7 - 2 Basic Hints and Tips
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Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don't forget to note the serial numbersif you are storing them out of their original cases, e.g. inaCD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). Thisis especially important if
you choose to use a Super visor password for the BIOS (see “ The Setup Utility” on page5 - 2).

» Keep copiesof vital settingsfiles such as network, dialup settings, mail settings etc.(even if just brief notes).

N2
2

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.

Backup and General Maintenance 7 - 3
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Viruses

» Ingtal an Anti-Virus program and keep the definitionsfile (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tionsfile updates are usually downloadable directly from the internet.

» Becareful when opening e-mail from sources you don’'t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

» Keepa“Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS's documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such adisk (or at
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software

Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

Don’'t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

Make sure you have installed the drivers for any new hardware you have installed (latest driver filesare
usually available to download from vendor’s websites).
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» Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

» Don't over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of aproblem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and

removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn't | Battery missing / incorrectly installed. Check the battery bay, make sure the
work. battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator ,is | Low Battery. Plug in the DC power source. If the computer doesn’t start up
blinking orange. immediately, turn it off then on again.

You are losing battery power too quickly. | The system is using too much power. If your OS has a Power Options scheme
(see “Shutting the Computer Down” on page 3 - 4) check its settings. You
may also be using a peripheral device/USB device that is drawing a lot of power.

Actual battery operating time is shorter | The battery has not been fully discharged before being recharged. Make sure
than expected. the battery is fully discharged and recharge it completely before reusing (see
pages 3 - 14 to 3 - 22).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/lUSB device is consuming a lot of power. Turn off/fremove
the unused device to save power.

. |
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Problem

Possible Cause - Solution

The computer feels too hot.

Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn't sitting on a thermal surface (see
“Overheating” on page 1 - 14). Make sure you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen.

The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 9).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you're connected to an external monitor, make sure
it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external
monitor | have plugged in and powered
on.

You haven't installed the video driver and configured it appropriately from the
Control Panel. See Appendix C for instructions on installing and configuring
the video driver.
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Problem

Possible Cause - Solution

You forget the boot password.

If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

AN
Ik

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows notification area, or use the key combination Fn
+ F5 and F6 (see “Function/Hot Key Indicators” on page 1 - 10) to adjust.

Unwelcome numbers when

typing.

appear

Num Lock is turned ON (see “Function/Hot Key Indicators” on page 1 - 10).

I am sliding my finger up and down on the
right side of the Touchpad to scroll a
Window and the Touchpad does not
respond.

There are different Touchpad versions available on this computer, and this
version requires tapping/holding to scroll. Either tap repeatedly, or hold the
finger down, at the top or bottom right of the Touchpad (depending on the
scrolling direction required) to scroll the window.
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Problem

Possible Cause - Solution

work.

4

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not

The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 7). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN/Bluetooth modules
cannot be detected.

The modules are off as the computer is in Airplane Mode. Check the LED
indicator to see if it is in Airplane Mode (see “System Map: LCD Panel
Open” on page 1 - 6). Use the Fn + F11 key combination to toggle Airplane
Mode on/off (see Table 1 - 3, on page 1 - 10).

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on page 1 - 10). Run the camera
application to view the camera picture.
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Problem Possible Cause - Solution

The Wireless LAN/Bluetooth modules | The driver(s) for the module(s) have not been installed. Make sure you have
cannot be configured. installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 6 - 1).

A file cannot be copied to/from a | The transfer of data between the computer and a Bluetooth enabled device is
connected Bluetooth device. supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process has been completed

| cannot obtain high speed Bluetooth data | To obtain high speed Bluetooth data transfer take into account the following:

transfer. « Toachieve high speed transfer speeds, both devices must support high
speed data transfer (i.e both the computer and the Bluetooth compati-
ble device you are connecting to).

* Check your Bluetooth compatible device's documentation to confirm it
supports high speed data transfer, and for configuration information.
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Problem

Possible Cause - Solution

| have used Update Driver in Device
Manager (Unknown device > Other
Devices) to try and install the Airplane
Mode driver. Windows encountered a
problem in attempting to update the driver,
and a yellow exclamation mark appears
in Device Manager against the Unknown
device.

It is very important that the drivers are installed in the order indicated in Chapter
4 (which is the numbered installation order on the Device Drivers & Utilities +
User’s Manual disc). This issue can occur when drivers are manually installed,
and not in the correct order.

If you have attempted to Update Driver from the Device Manager control panel
and have encountered problems, then use the method below to correct this:

To correct this problem:

1. Go tothe Programs and Features (Programs) control panel in
Windows.

2. Select any installed Airplane Mode driver item (e.g. Insyde Airplane
Mode HID Mini-Driver), and click Uninstall/Change to uninstall the
current driver.

3. Restart the computer.

4. Insert the Device Drivers & Utilities + User’'s Manual disc and click
Install Drivers (button).

5. Double-click the Airplane Driver item in the menu.

6. Follow the instructions to install the correct driver (you will need to
restart the computer as part of the installation process).
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Problem Possible Cause - Solution

When using a Bluetooth headset the | This is a common issue with Bluetooth headsets. To resolve this issue do the
audio appears to be mono and not | following (you will need to repeat this procedure after every boot up, restart,
stereo. or when the system resumes from hibernation):

Go to the Devices & Printers control panel in Windows.
Double-click the Bluetooth headset.
Click Connect to complete the stereo connection.

Go to the Sound control panel in Windows.

Right-click (in the Playback tab) the Bluetooth Stereo Audio device
(the default device is Headset).

Click Connect to complete the stereo connection.

NEOWDNE
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3G/4G Module PIN Code & Power-Saving

Note that there may be someissueswhen aPIN Codeis set for a3G/4G module (if you are unsure of your module
version contact your distributor/supplier) in Windows, if Mobile Broadband has been turned off, and the system
has resumed from a power-saving state. To prevent any issuesit isrecommended that you ssimply do not en-
ableaPIN for a 3G/4G module. The following provides instructions for disabling the PIN code.

Disabling a PIN code for a 3G/4G Module

1. Go tothe Charms Bar.
2. Click Change PC Settings.

6"

* I‘a) ‘0-
67

Available Brightness

2 o

Notifications Power Keyboard

Change PC settings )

Figure7 - 1 - Change PC Settings
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Troubleshooting

Click Network.

Click the broadband connection under Mobile Broadband.

Scroll down to Security and click Remove PIN.

Enter the current PIN number and click OK.

It is recommended that you do not Enable a PIN for a 3G/4G module.

-

-

Figure7 - 2 - Disable PIN
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Resolving the “Insert a SIM” issue with the 3G/4G Module (Windows 8.1)

1. If a PIN was set for the 3G/4G module, you have then switched Mobile broadband off (or put the system in
Airplane Mode) in Networks, and the system has just resumed from a power-saving state the following error
may occur.

On resuming from the power-saving state the standard procedure would be to go to Networks in the Charms
Bar and turn on Mobile broadband.

Go to the Charms Bar.

Select Settings and you will then note that the WiFi icon will read Unavailable.

Standard procedure would be to click the connection and enter the PIN number to unlock the connection.

In this instance you will note that the Mobile broadband connection will read Insert a SIM.

In this case you will need to restart the computer.

After system restart you can then connect to the Mobile Broadband as normal.

To fully resolve this issue it is recommended that you do not Enable a PIN a 3G/4G module.

n
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Interface (Ports & Jacks)

Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give aquick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.
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Notebook Ports and Jacks

ltem

Description

Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack

Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA)
Port

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD.

HDMI-Out Port

The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals.

Headphone-Out Jack

Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.
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Item Description
Microphone-In Jack Plug an external microphone in to this jack to record on your computer.
RJ-45 LAN Jack This port supports LAN (Network) functions.

Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

USB 2.0/1.1 Port The USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals
such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs,
digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and

USB 3.0 Port unplugged from the computer, without the need to turn the system off (if the power rating of your
USB device is 500mA or above, make sure you use the power supply which comes with the
device).

3.0

The USB 3.0 port is denoted by its blue color; and the USB 2.0 ports are colored black. USB
3.0 will transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0.

.|
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Appendix B: Control Center

Overview

The following chapter will give a quick description of the functions of the Control Center. The Control Center
givesquick accessto frequently used controls, power management features and enables you to quickly turn mod-
ules on/off. Click the Control Center iconsto toggle the appropriate function, or hold the mouse button down
and movethedial control where applicable. Certain functionswill automatically be adjusted when a power mode
is selected. The Control Center in Windows 8.1 works under the Desktop App and not under the Start screen.

4

Control Center Access

To run the Control Center press
the Fn + Esc key combination or
double-click the icon in the
notification area of the taskbar. ﬂ
Close the Control Center by
clicking the close icon in the
top right of the panel (move the

cursor onto the top right corner
of the panel to highlight it).

Figure B - 1 - Control Center
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Power Modes
Y ou can set a Power M ode by clicking the appropriate icon at the top of the Control Center. Each power
mode will affect the Power Conservation Mode, Airplane Mode, Power Plan and PC camera power etc.

You can click a Control Center icon to set an overall power mode and then click individual iconsin the
Control Center to power on/off the Touchpad and PC camera.

Modes Quiet Power Saving Performance Entertainment
Icon
Power Plan Balanced Power Saver High Performance Balanced
Power Conservation Mode Balance Energy Star Performance Balance
PC Camera ON OFF ON ON
TouchPad ON ON ON ON
Airplane Mode OFF ON OFF OFF

Table B - 1- Power Modes
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Control Center Menus
The Control Center contains 2 menu headings (System Program & Device) under the Power Modes. Click
the menu headings and then click any of the buttons outlined on the following pages.

Figure B - 2 - Control Center Menus
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Power Status (System Program) /
The Power Statusicon will show whether you are currently powered by the battery, or by the AC/DC adapter
plugged in to aworking power outlet. The power status bar will show the current battery charge state.

Brightness (System Program)
The Brightness icon will show the current screen brightness level. You can use the slider to adjust the screen
brightness or the Fn + F8/F9 key combinations, or use the Fn+ F2 key combination to turn off the LED backlight
(press any key to turn it on again).

Volume (System Program)
The Volume icon will show the current volume level. Y ou can use the slider to adjust the Volume or the Fn +
F5/F6 key combinations, or use the Fn+ F3 key combination to mute the volume.

Fan Speed (System Program)

Y ou can set thefan speed to M aximum (full power), Automatic or Custom from this menu item. The fan speed
will adjust itself automatically to control the heat of the CPU. However you can adjust the setting to maximum
if you prefer. Select Custom and click on the sliders to adjust the settings to your preference, however these set-
tings can be overridden by the system, as a safety precaution, if it requires heavier use of the fan.

4

Custom Settings

Click Save to retain customized settings, or Reset to select default settings.
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Power Conservation (System Program)

This system supports Ener gy Star power

management features that place computers (CPU, hard drive, etc.) into alow-power sleep modes after a desig-
nated period of inactivity (see “ Power Conservation Modes’ on page 3 - 12). Click either the Perfor mance,
Balanced or Energy Star button.

Sleep Button (System Program)
Click either the Hiber nate or Sleep buttons to have the computer enter the selected power-saving mode when
the sleep key combination is pressed (see “ Power-Saving States’ on page 3 - 7).

Display Switch (System Program)
Click the Display Switch button to access the menu (or use the 3§ + P key combination) and select the appro-
priate attached display mode.

Time Zone (System Program)
Clicking the Time Zone button will access the Date and Time Windows control panel. ﬂ

Desktop Background (System Program)
Clicking the Desktop Background button will alow you to change the desktop background picture.
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TouchPad/PC Camera (Device)

Click either of these buttons to

toggle the TouchPad or camera

modul €' s power status. Theicon will appear dimmed when it is disabled. Note that the power status of the camera
module is also effected by the Power M ode selected (see Table B - 1, on page B - 2).

Caps Lock/Scroll Lock/ Number Lock/Airplane Mode
Click the button to toggle the appropriate lock mode and Airplane Mode.
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Appendix C: Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features’ on
page 1 - 25.

Intel Video Driver Installation
Make sure you install the driversin the order indicated in Table 4 - 1, on page 4 - 4.

1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes> Next > Next.
3. Click Finish to restart the computer.

Dynamic Video Memory Technology

Intel® DVMT automatically and dynamically allocates as much (up to 1748M B)
system memory (RAM) as needed to the integrated video system (the video driver
must beinstalled). DVMT returns whatever memory is no longer needed to the op-
erating system.

Intel Video Driver Installation C - 1

4

Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your distributor/supplier
for the latest details on
video cards supported.

DVMT Notes

DVMT is not local video
memory.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory indi-
cated.



Video Driver Controls

Intel® HD Graphics Control Panel

Advanced video configuration options are provided by the Intel®@ HD Control Pan-
el. To access the control panel see below and overleaf:

1. Click the Intel® HD Graphics Control Panel icon in the Apps screen.

FigureC-1
Apps Screen
Intel® HD Graphics
Control Panel

(seeover)

C - 2 Intel® HD Graphics Control Panel



Video Driver Controls

OR

2. Right-click the Desktop and select Graphics Properties from the menu.

OR

3. Click Advanced settings in the Screen Resolution control panel in Windows.

4. Click the Intel(R) HD Graphics Control Panel tab and click Graphics Properties
(button).

5. Double-click the Intel(R) HD Graphics control panel in the Windows Control
Panel.

FigureC- 2
Intel® HD Graphics
Control Panel
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Y ou may make changesto any of the graphics properties by clicking the appropriate
menu panel and adjusting the settings from the menus.

FigureC- 3
Intel® HD Graphics
Control Panel
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Sub-Menus
Some of the menu panelswill also have sub-menus (in the top left corner of the menu
alongside the icon (%) to display further configuration options.

FigureC-4
Intel® HD Graphics
Control Panel
Sub-Menus
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Display
Z \ Click either Display Settings or Color Settings to make display adjustments, in-
Multiple Display cluding configuration for any attached external displays.
At least one other dis-
play must be attached in < \;

order to view multiple
display selection op-
tions.

FigureC-5
Intel® HD Graphics
Control Panel
Display Settings
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Click the Display menu at the top of the screen to display the sub-menus. The M ul-
tiple Displays menu allows you to configure the display mode of any attached dis- Z
plays (see” Attaching Other Displays’ on page C - 17). Multiple Display
At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

Audio Settings

Any attached active dis-
plays must have audio
capacity to allow audio
configuration.

FigureC-6

Intel® HD Graphics

Control Panel
Display Settings -
Multiple Displays
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The Custom Resolutions sub-menu allows you to adjust the display (or any at-
tached display) to any width, height, refresh rate, color depth and underscan percent-
age of your choice. Note that incorrect settings can cause system instability and even
possible component damage, so thisis adjusted at your own risk.

FigureC-7
Intel® HD Graphics
Control Panel
Display Settings -
Custom
Resolutions
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3D

This menu allows you to choose how 3D images are displayed. Performance Qual-
ity displaysthe most detail, Balanced M ode provides better computer performance
with good quality and Custom allows you to configure the Anisotropic Filtering
and Vertical Sync and features to your preferences. Click Apply to save changes.

FigureC-8
Intel® HD Graphics
Control Panel 3D
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Options and Support
Hot Key Manager in Optionsand Support allowsyou to create hot keysfor open-
ing the application, rotating the display, scaling etc. Click Apply to save changes.

FigureC-9
Intel® HD Graphics
Control Panel
Options and
Support

C - 10 Intel® HD Graphics Control Panel



Video Driver Controls

Click the Options menu at the top of the screen to display the sub-menus. The In-
formation Center provides details on System Information, the Built-1n Display Z
and any attached displays.

Preferences
Go to the Preferences
sub-menu in Options to
configure the preferences
for the Intel® HD Graphics
Control Panel.

Make sure you Enable
Tray Icon to display the In-

tel® HD Graphics Control
Panel icon in the notifica-
tion area of the taskbar (as
below).

FigureC- 10

Intel® HD Graphics
Control Panel
Options -
Information Center
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Video

The Video Profiles menu allows you to brighten or darken movies, or to switch to
vivid colors. The Preview image will display a sample image using the current set-
tings. You can Save Profile and name the Profile to recall the settings at any time.

Click Apply to save changes (select Color Enhancement, | mage Enhancement,
or Image Scaling from the menu).

FigureC- 11
Intel® HD Graphics
Control Panel -
Video
(Color
Enhancement)
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Click the Video menu at the top of the screen to display the sub-menus.The Image
Enhancement menu allows you to adjust the Shar pness, Noise Reduction, Con-
trast Enhancement and Film M ode Detection etc. Click Apply to save changes.

FigureC - 12
Intel® HD Graphics
Control Panel -
Video
(Image
Enhancement
Basic)
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Turn Image Scaling on, and use the sliders to adjust the scaling.

FigureC- 13
Intel® HD Graphics
Control Panel Video

Image Scaling
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Power

There are two separate menus to adjust the power settings for whenever the comput-
er isPlugged In or On Battery. Maximum Battery Life will reduce graphics per-
formance for power saving, Balanced will provide full graphics performance when
required and minimize power consumption when inactive, and Maximum Perfor -
mance will give top graphics performance but requires more power.

FigureC- 14
Intel® HD Graphics
Control Panel -
Power

.|
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Display Devices & Options

Note that you can use external displays connected to the HDMI-Out port and/or ex-

ternal monitor port. See your display device manual to see which formats are sup-
ported.

4
Attaching Displays

When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
HD Graphics Control Panel to configure the full screen display.

Display Mode Description
Single Display One of the connected displays is used as the display device (PC
screen only or Second screen only).
TableC-1 _ _ _
C Display Modes Clone/Duplicate _Both connected displays output the same view and may be configured
independently

Extended / Extend B‘_oth connected displays are treated as separate devices, and act as a
virtual desktop
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Attaching Other Displays

. e
To Clone Displays: _ .
; ) ; ; Multiple Display

1. Attach your external display to the HDMI-Out port/external monitor port, and turn it on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display >

Multiple Displays (sub-menu). play must be attached in
3. Click Clone from the Select Display Mode menu. order to view Multiple
4. Click Apply, and OK to confirm the settings change. Display selection op-
5. Select the displays from the Select One or More Active Displays menu. tions.

At least one other dis-

FigureC- 15
Display > Multiple
Displays (Clone)
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4

Display Settings
Extended Desktop

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

You can drag the moni-
tor icons to match the
physical layout of your
displays. Icons and pro-
grams may also be
dragged between the
displays.

FigureC- 16
Display > Multiple
Displays (Extended)

To Enable Extended Mode;:

Attach your external display to the HDMI-Out port/external monitor port, and turn it on.
Go to the Intel(R) HD Graphics Control Panel control panel and click Display >

1.
2.

w

Multiple Displays (sub-menu).
Click Extended from the Select Display Mode menu.
Click Apply, and OK to confirm the settings change.

Click the appropri-
ate monitor icon
and drag it to match
the physica ar-
rangement you
wish to use (e.g. the
secondary display
may be extended
left/right/above/be-
low the primary dis-
play).
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Attaching Other Displays - Devices (Charms Bar)

Y ou can configure attached displays from Devices (in the Charms Bar).

1. Attach your external display to the HDMI-Out port/external monitor port, and turn it on.

2. Gothe Charms Bar, select Devices.

3. Click Project (you may need to click Second Screen).

4. Click on any one of the options from the menu to select PC screen only,
Duplicate, Extend or Second screen only.

Attaching Other Displays - Devices (Charms Bar) C - 19

4

Windows Logo Key
am + P Key
Combination

You can use the 58 + P
key combination to
quickly bring up the Sec-
ond Screen menu.

You can also use the
Display Switch button
in the Control Center to
access the menu and
select the appropriate
attached display mode.

You can also use the Fn
+F7 key combination to
quickly access the Sec-
ond Screen menu in
Windows.

FigureC - 17
Second Screen
(Devices)
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Configuring an External Display In Windows

1. Attach your external display to the HDMI-Out port/external monitor port, and turn it on.
2. Go to the Screen resolution control panel (see page 1 - 26) in the Desktop app.

3. Click the Detect button.

4. The computer will then detect any attached displays.

FigureC - 18
Screen Resolution
Multiple Displays
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5. You can configure the displays from the Multiple Displays menu.

FigureC- 19
Screen Resolution
Multiple Display
Options

» Duplicate these displays - Shows an exact copy of the main display desktop on
the other display(s)

» Extend these displays - Treats both connected displays as separ ate devices

» Show desktop only on 1/2 - Only one of your displaysis used.

.|
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4

Volume Adjustment

The sound volume level
can be set using the vol-
ume control in the Set-
tings menu in the
Charms Bar.

FigureC- 20
Sound - HDMI
Device (set Default)

HDMI Audio Configuration

HDMI (High-Definition Multimedialnterface) carries both audio and video signals.
In some cases it will be necessary to go to the Sound control panel and manually
configure the HDMI audio output as per the instructions below.

1. Goto the Control Panel.

2. Click Sound (Hardware and Sound) and click Playback (tab)

3. Depending on your display, the playback device may be selected, however in some
cases you may need to select the audio device and click Set Default (button).

4. Double-click the device to access the control panel tabs illustrated overleaf.

C - 22 HDMI Audio Configuration
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5. Adjust the HDMI settings from the control panel tabs.
6. Click OK to close the Sound control panel.

FigureC- 21
HDMI Device
Properties

HDMI Audio Configuration C - 23
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HDMI Notes
A » Connect adevice with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.
» To play audio sources through your external display’s (TV or LCD) speakers
If you are using a third you will need to go to the audio configuration control panel on the display and

party application to play . . . . . .
DVDs ete, from any at- configure the audio input accordingly (see your display device manual).

tached - DVD device, | i\ video Configuration
you will need to consult .
1. Connect an HDMI cable from the HDMI-Out port to your external display.

the application’s docu- . . . . . g
mentation to see the 2. Configure your external display as per the instructions in “Attaching Other

Other Applications

appropriate audio con- Displays” on page C - 17.

figuration (the applica- 3. Set up your external display (TV or LCD) for HDMI input (see your display device
tion must support digital manual).

to analog translation). 4. You can now play video/audio sources through your external display.

.|
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Appendix D: Specifications
e

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your distributor/supplier for details.

.|
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Specifications

Intel® Core™ i7-5500U (2.4GHz)
4M L3 Cache, 14nm (14 Nanometer),
DDR3L-1600MHz, TDP 15W

Intel® Core™ i5-5200U (2.2GHz)
3M L3 Cache, 14nm (14 Nanometer),
DDR3L-1600MHz, TDP 15W

Intel® Core™ i3-5010U (2.1GHz)
3M L3 Cache, 14nm (14 Nanometer),
DDR3L-1600MHz, TDP 15W

Intel® Core™ i3-5050U (2.0GHz)
3M L3 Cache, 14nm (14 Nanometer),
DDR3L-1600MHz, TDP 15W

Intel® Pentium® 3805U (1.9GHz)
2M L3 Cache, 22nm (22 Nanometer),
DDR3L-1600MHz, TDP 15W

Intel® Celeron® 3755U (1.70GHz)
2M L3 Cache, 22nm (22 Nanometer),
DDR3L-1600MHz, TDP 15W

Intel® Celeron® 3205U (1.50GHz)
2M L3 Cache, 22nm (22 Nanometer),
DDR3L-1600MHz, TDP 15W

D - 2 Specifications

13.3"/ 33.78cm QHD+ (3200 * 1800),
WQHD (2560 * 1440), FHD (1920 *
1080), HD+ (1600 * 900),

2.85mm Thick 16:9 Backlit Panel

Dual Channel DDR3L

Two 204 Pin SO-DIMM Sockets
Supporting DDR3L 1600 MHz Memory
Modules (real operational frequency
depends on the FSB of the processor)
Memory Expandable up to 16GB
Compatible with 2GB, 4GB or 8GB Modules

Intel® HD Graphics 5000

(Integrated with i7-5500U / i5-5200U/ i3-
50100/ i3-5005U CPUs)

Dynamic Frequency

Intel Dynamic Video Memory Technology
up to 1.7MB

Microsoft DirectX®11.1 Compatible

Intel® HD Graphics

(Integrated with Pentium® 3805U /
Celeron® 3755U/ Celeron® 3205U
CPUs)

Dynamic Frequency

Intel Dynamic Video Memory Technology
up to 1.7MB

Microsoft DirectX®11.1 Compatible

One Changeable 2.5" / 7.0 mm (h) HDD/
SSD with SATA (Serial) Interface

One M.2 SSD with SATA (Serial)
Interface (Factory Option)

High Definition Audio Interface
Built-In Microphone
2 * Built-In Speakers

Built-in TouchPad with Multi-Gesture and
Scrolling Functionality

A4 Size Isolated Keyboard




Two USB 2.0 Ports

One USB 3.0 Port

One External Monitor Port

One HDMI-Out (High-Definition
Multimedia Interface) Port (with HDCP)
One Headphone-Out Jack

One Microphone-In Jack

One RJ-45 LAN Jack

One DC-In Jack

Embedded Multi-In-1 Card Reader

- MMC/ RS MMC
- SD/ Mini SD / SDHC/ SDXC

Note: Some of these cards require PC
adapters that are usually supplied with
the cards.

Three M.2 Slots:

For i7-5500U / i5-5200U / i3-5010U /
Celeron® 3755U CPUs:

Slot 1: for M.2 WLAN Combo Module with
PCle & USB Interfaces

Slot 2: for M.2 SSD with SATA/ PCl-e * 2
Interface

Slot 3: for M.2 3G Module (UTMS/HSPA+)
with USB Interface OR M.2 LTE 4G Mod-
ule with USB Interface (Factory Option)

For For i3-5005U, Pentium® 3805U /
Celeron® 3205U CPUs:

Slot 1: for M.2 WLAN Combo Module with
PCle & USB Interfaces
Slot 2: for M.2 SSD with SATA Interface

Slot 3: for M.2 3G Module (UTMS/
HSPA+) with USB Interface OR M.2 LTE
Module with USB Interface

Specifications

Built-In 10/100/2000Mb Base-TX
Ethernet LAN

Intel® Dual Band Wireless-AC 7265
(2*2 802.11 alc) M.2 2230 WLAN + Blue-
tooth Combo Module (Factory Option)

Intel® Dual Band Wireless-AC 3160
(1*1 802.11 a/c) M.2 WLAN + Bluetooth
Combo Module (Factory Option)

3rd Party M.2 2230 Combo WLAN
(802.11b/g/n) + Bluetooth v4.0+LE
Module (Factory Option)

3G UTMS/HSPA+ M.2 3042 Card Module
(Factory Option)

OR

4G LTE M.2 3042 Card Module (Factory
Option)

Quad-band GSM/GPRS (850 MHz, 900
MHz, 1800 MHz, 1900 MHz)

UMTS WCDMA FDD (2100 MHz)

Note that UMTS modes CAN NOT be
used in North America

1.0M HD Video Camera Module with
USB interface (Factory Option)
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Specifications

Supports Wake on LAN

Supports Wake on USB

Supports Wake on RTC Alarm (AC Mode
Only)

Full Range AC/DC Adapter
AC input 100 - 240V, 50 - 60Hz,
DC Output 19V, 2.1A (40 Watts)

Removable 3 Cell Smart Lithium lon
Battery Pack 24WH

Removable 3 Cell Smart Lithium lon
Battery Pack 31WH (Factory Option)

Security (Kensington® Type) Lock Slot
BIOS Password
Intel® PTT

Painted Style (for Some Model Designs)

Windows® 10 (64-bit)
Windows® 8.1 (64-bit)
Windows® 7 (64-bit)

LED Indicators - Power/Suspend, Battery,
HDD/ODD, Airplane Mode, Camera

One 48Mb SPI Flash ROM
AMI BIOS

Temperature
Operating: 5°C -35°C
Non-Operating: -20°C - 60°C

Relative Humidity
Operating:
Non-Operating:

20% - 80%
10% - 90%

326mm(w) * 231mm(d) * 23.6mm(h)
(Height excluding battery area)

1.4 kg *Barebone System with 24WH
Battery & ODD

A barebone system does not include the HDD,
RAM, adapter, power cord, VGA card and factory
option modules (weight tolerance within +/- 5%).
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Appendix E: Windows 7

Overview

This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows 7 OS.

Y ou can refer to the main manual for details of driversrequired, audio & video information, BIOS, modules etc.
However any information specific to Windows 7 will be included in this Appendix, as well as details on how to
navigate the Windows 7 user interface to access the applications, control panels, taskbar etc.

System Software

Y our computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for adifferent system, you will find the Windows 7 (64-bit with Service Pack
1 installed) operating system is supported.

4

Windows Versions

Note that the information included on the following pages is for Windows 7 (64-bit) only.
Windows OS

In order to run Windows 7 (64-bit with Service Pack 1) your computer requires a minimum 2GB of system memory
(RAM).
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Windows 7

Function/Hot Key Indicators (Windows 7)

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility isinstalled.

Keys Function Keys Function
] S Brightness
Fn + Play/Pause (in Audio/Video Programs) Fn + Decrease/
Increase
Touchpad Toggle
Fn+ (Disable toggle by Fn + PPC Ca_lrmer?
using the Touchpad ower loggle
Fn + Turn LCD Backlight Off Fn + Airplane
(Press a key to or use TouchPad to turn on) Mode Toggle
En + Fn + Number Lock
Mute Toggle Toggle
Scroll Lock
Fn + Sleep Toggle En + Toggle
g_ Fn + Volurlne Decrease/ C:ilrps LIOCk
S ncrease oggle
o
= Fn + Display Switch Menu Fan Control
é En + Toggle -
w Maximum /
~ Table E - 1 - Function & Hot Key Indicators Automatic

. |
E - 2 Overview



Windows 7

Control Center

Press the Fn + Esc key combination, or double-click the icon in the notification area of the taskbar to
toggle the Control Center on/off. The Control Center gives quick access to frequently used controls and en-
ables you to quickly turn the camera/touch pad on/off (see Appendix B for full details).

4

Control Center Access

To run the

Control Cen-
ter press the
Fn + Esc

key combi-
nation, or
double-click
the icon

in the notifi-
cation area
of the task-
bar.

Close the Control Center by clicking the

close icon in the top right of the panel
(move the cursor onto the top right corner
of the panel to highlight it).

Figure E - 1 - Control Center

. |
Overview E - 3
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Windows 7

Windows 7 Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows 7 are accessed from the Start menu. When
you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be
placed in the Start menu and/or the desktop. Right-click the Start menuicon , and then select Propertiesto
customize the appearance of the Start menu.

Click here to toggle Category View

Figure E - 2 - Start Menu & Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
inWindows (e.g. power, video, network, audio etc.). Windows 7 provides basic controlsfor many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

. |
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Video Features

Y ou can switch display devices, and configure display options, from the Display control panel (in Appear ances
and Personalization) in Windows 7. For more detailed video information see “Video Driver Controls’ on
page C - 1. To access Display (Control Panel) and Screen Resolution in Windows:

Click Start and click Control Panel.

Click Display (Appearances and Personalization category) and click Adjust resolution.
Use the drop box to select the screen Resolution @ (Figure E - 3).

Click OK to confirm setting changes.

Click Advanced settings @ (Figure E - 3) to bring up the Advanced properties tabs.

4

Right-Click Desktop
App

You can also right-click
the desktop and select

o Screen resolution @
to quickly access the
control panel.

S
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Figure E - 3 - Screen Resolution
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Windows 7

To access the I ntel (R) HD Graphics Control Panel:

1. Click Advanced settings @ (Figure E - 3 on page E - 5) in the Display Settings control panel in Windows.
2. Click Graphics Properties (button) @ (Figure E - 4) in the Intel(R) HD Graphics Control Panel tab.

OR

3. Right-click the desktop and select Graphics Properties @ (Figure E - 4) from the menu.

OR I-_E:-:

4. Click the icon @ (Figure E - 4) in the taskbar notification area and select Graphics Properties from the menu.
OR

5. Access the Intel(R) HD Graphics Control Panel from the Windows control panel in Classic View.

(G

Figure E - 4 - Intel(R) HD Graphics Control Panel Access
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Power Options

ThePower Options (Hardwar eand Sound menu) control panel icon in Windows allows you to configure pow-
er management features for your computer. Y ou can conserve power by means of power plans and configure
the options for the power button, sleep button, computer lid (when closed), display and sleep mode from the
left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create anew plan. Click Change plan settings and click Change advanced power settingsto access further con-
figuration options. Pay attention to the instructions on battery care in “ Battery I nformation” on page 3 - 14.
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Figure E - 5 - Power Options
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e Drivers & Utilities (Windows 7)
, = _ Make sure you install all the drivers and utilities for your system.
Driver Installation &

FOWEE What to Install

WEEEIELWCEC IS The Device Drivers & Utilities + User’s Manual disc contains the drivers and util-

k - .
o ;T:?ere < ”;Wé?gé ities necessary for the proper operation of the computer. Table E - 2, on page E - 10

S Nellsler o f listswhat you need toinstall and it isvery important that thedriversareinstalled
ollicmize e 8 in the order indicated.

ing power source.
Some drivers draw a

o Notethat theinformation included on thefollowing pagesisfor Windows 7 only. See
significant amount of

“Drivers& Utilities(Win 8.1)” on page 4 - 1 for information on drivers and utilities

power during the instal-
lation procedure, and if for the Windows 8.1 operatl ng system.
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and

cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).
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Driver In Stal | at| on (W| n 7) 1. Check the driver installation order from Table E - 2,
on page E - 10 (the drivers must be installed in

Insert the Device Drivers & Utilities+ User’s Manual this order) which is the same as that listed in the

disc and click I nstall Drivers (button), or Option Driv- Drivers Installer menu below.

ers (button) to access the Optional driver menu. 2. Click to select the driver you wish to install, (you

should note down the drivers as you install them).
3. Follow the instructions for each individual driver
installation procedure as listed on the following

pages.

=

Figure E - 6 - Drivers Installer Screen 1 (Win 7) %

=

Note: If you need to reinstall any driver, you should uninstall the 2
driver first. Figure E - 7 - Drivers Installer Screen 2 (Win 7) ~

.|
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Win 7 (64-bit) Driver Page # Win 7 - Optional Items Page #
Chipset Page E - 12 PC Camera Module (Windows 7) Page E - 16
Video (VGA) Page E - 13 Wireless LAN (Windows 7) Page E - 23
LAN Page E - 13 Bluetooth & WLAN Combo Module (Windows 7) Page E - 28
CardReader Page E - 13 3G/4G Module (Windows 7) Page E - 34
Touchpad Page E - 13 Intel Rapid Storage Technology (Windows 7) Page E - 40
Hot Key Page E - 13 Intel® Wireless Display Application (Windows 7) Page E - 41
USB 3.0 Page E - 13

MEI Driver Page E - 14

Audio Page E - 14

Table E - 2 - Driver Installation
All drivers provided are for the Windows 7 (64-bit with Service Pack 1) operating system.
Notethat you need toinstall both the WLAN & Bluetooth driversfor the WLAN & Bluetooth Combo modules.
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Manual Driver Installation

Click Browse CD/DVD (button) in the DriversInstall-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update
After installing al the drivers make sure you enable
Windows Updatein order to get all the latest security
updates etc. (all updateswill includethe latest hotfixes
from Microsoft). See“ Windows Update” on page E -
14 for instructions.

Windows 7

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if itisnot listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.

Driver Installation (Win 7) E - 11
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Windows 7

User Account Control

If aUser Account Control prompt appears as part of
the driver installation procedure, click Continue/Al-
low, and follow the installation procedure as directed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or Install to continue thein-
stallation procedure.

Y ou will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found

If you see the message “New Har dwar e Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.

Driver Installation Procedure

Insert the Device Drivers & Utilities+ User’s Manual
disc and click I nstall Drivers (button), or Option Driv-
ers (button) to access the Optional driver menu.

4

Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 6 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slightly.
As a general guide follow the default on screen instruc-
tions for each driver (e.g. Next > Next > Finish) unless
you are an advanced user. In many cases a restart is re-
quired to install the driver.

Chipset

Click 1.Install Chipset Driver > Yes.

Click Next.

Click the Accept button to agree to the license.
Click Install.

Click Finish to complete the installation.

s owbdNE
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Windows 7

Video (VGA) CardReader
1. Click 2.Install VGA Driver > Yes. 1. Click 4.Install Cardreader Driver > Yes.
2. Click Next > Yes> Next > Next. 2. Click Finish.

3. Click Finish to restart the computer.
Touchpad
Note: After installing the video driver go to the Dis- 1, Click 5.Install Touchpad Driver > Yes.
play/Display Settings control panel to adjust thevid- 2 CJick Next.
€0 settings to the highest resol ution. 3. Click thebutton to accept the license agreement
and click Next.

LAN 4. Click Finish > Restart Now to restart the com-

Note: If the computer enters a deep sleep mode during

installation, you will be prompted to plug in a network pUte.
cable, and click OK, to continue installation. If a net-
work cable is not available, restart the systemand re- Hot Key

2. Click Next.

1. Click 3.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish. USB 3.0

1. Click 7.Install USB 3.0 Driver > Yes.
2. Click Next > Yes> Next > Next.
3. Click Finish to restart the computer.

3. Click Finish to restart the computer.
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MEI Driver

1. Click 8.Install MEI Driver > Yes.

2. Click Next.

3. Click the check box to accept the license and
then click Next.

It isrecommended you now also install the Intel Rap-
id Storage Technology driver (see “Intel® Rapid
Storage Technology” on page6 - 21 - required for
AHCI mode hard disks).

4. Click Next. Z
5. Click Finish. Windows Update

After installing all the drivers make sure you enable Win-
Audio dows Update in order to get all the latest security up-

1. Click 9.Install Audio Driver > Yes.
2. Click Next.

dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-

3. Click Finish to restart the computer. nected to the internet:
1. Click Start, and click Control Panel (or point to
Note that after installing the audio driver the system Settings and click Control Panel). .
will not return to the Drivers Ingtaller screen. Toin- | % g'e'zkr‘,’:’;)“dows Llpelsite (2ysiem g Seaun
. . . . urity).
E stall any of th_e optional _d_rl_vers Ilsted’overleaf, ejt_act R G e e —
= the Device Drivers & Utilities + User’s Manual disc 4. The computer will now check for updates (you
o and thenreinsert it (or double-click thedisciconinMy need to be connected to the internet).
% Computer), and click Option Drivers (button) to ac- 5. Click Install now (button) to begin checking for the
; ; updates.
n cessthe optlonal driver menu. 6. Click Install updates (button) to install the
~ updates.
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Windows Experience Index Optional Drivers
After Video (VGA) driver has been installed, and the o 410 pagesindicated in Table E - 2, on page E - 10

f’ﬁe?atmﬂﬁrtted’aihihos V\:c'” automalt;callyhr un the for the driver installation procedures for any modules
InSal.exe” 1o rae the performance. 11 you Ve re- . qeq in your purchase option.

started the system during this time then follow the in-
structions below to update the information.

After the drivers are installed follow this procedure to
ensure an accurate rating from the Windows Experi-
ence | ndex (make sure the AC/DC adapter is plugged
in):

1. Click Sart, and click Control Panel.

2. Click Performance Information and Tools
(System and Security > System > Check the
Windows Experience | ndex).

3. Click “Ratethis computer/Refresh Now/Re-
run the assessment”.

4. The computer will take afew minutes to assess

the system performance. Note that you need to install both the WLAN & Blue-
tooth driversfor Intel and 3rd party WLAN & Blue-
tooth Combo modules.

Figure E - 8 - Option Drivers (Win 7)

5. Closethe control panel.
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PC Camera Module (Windows 7)

\N A/

’ﬁl‘ Before installing the Windows 7 PC Camer a driver, make sure that the optional PC
S EER ] Camerais on. Usethe Fn + F10 key combination (see“ Function/Hot Key Indica-
SUERMEELRIRY (<" on page 1 - 10) or Control Center button to toggle power tothe PC Camera

o) a2 8 module. Make sure you install the driversin the order indicated in Table E - 2, on

ers & Utilities + User’s page E - 10.
Manual disc, and any

SeeelyER N RE Sl \When the PC Camera application is run the LED indicator to the left of the camera

e Sl will beilluminated (see @ Figure 1- 2 on page 1 - 6).
dated information on the

o ceubes B M ake sur e you access the application via the desktop shortcut.
which may override the
information provided
here.

N2
2

PC Camera Application and Power-Saving States

If the computer enters Sleep or Hibernate mode while running the camera application, the
program will stop running, and will need to be restarted when the system resumes from the
power-saving state.

PC Camera Driver Uninstallation

If you need to uninstall the driver, then uninstall the WebCam Installer item from the Pro-
grams and Features control panel in Windows.
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PC Camera Driver Installation

1. Make sure the moduleis powered on, and then insert the Device Drivers & ﬁ
Utilities + User’s Manual disc into an attached DVD drive. PC Camera Screen

2. Click Option Drivers (button). Refresh

3. Click 1.Install Webcam Driver > Yes. ey S ————

4. Click Finish to restart the computer. supports a frame rate of

5. Run the camera application program from the desktop shortcut (if the hard- 12 fps. If you find that
ware isturned off use the Fn + F10 key combination to turn it on again). the screen refresh rate

is subject to lag or stut-
PC Camera Audio Setup tering, then reduce the

If you wish to capture video & audio with your camera, it is necessary to setup the FRWIEENESIFATREISEEES
audio recording options in Windows. e QIpUiL (@2 Sl

Color Space Compres-

1. Click Start, and click Control Panel (or point to Settings and click Control Panel). sion.
2. Click Sound (Hardware and Sound). ,
3. Click Recording (tab). To reduce Output Size
4. Right-click Microphone and make sure the item is not disabled. el OIS Sl
. . . . . Compression run the

5. Double-click Microphone (or select Properties from the right-click menu). camera application
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to click Options and select

the level required. Video Capture Pin. Ad- §
7. Click OK and close the control panels. just the settings from the >
8. Run the camera application program from the desktop shortcut. appropriate  pull-down g—
9. Go tothe Devices menu heading and select Digital Mic (Realtek High Definition menu. <

Audio) (it should have a check alongside it). n
10. Go to the Capture menu heading and select Capture Audio (it should have a ~

check alongside it).

PC Camera Module (Windows 7) E - 17
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Right-click
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Figure E - 9 - Audio Setup for PC Camera
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Camera Application
The camera application isavideo viewer for general purpose video viewing and testing, and for capturing video
filesto.avi format.

1. Run the camera application from the desktop shortcut (it is recommended that you set the capture file before
the capture process - see Set Capture File below).

2. Gotothe Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page E -
17) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the video, and press Esc to stop
the capture (you can view the file using the Windows Media Player).

Set Capture File

Prior to capturing video files you may select the Set Capture File... option in the File menu, and set the file
name and location before capture (thiswill help avoid accidentally overwriting files). Set the name and location
then click Open, then set the“ Capturefilesize:” and click OK. Y ou can then start the capture process as above.

Note the important information in “ Reducing Video File Size” on page E - 20 in order to save file space, and
help prevent system problems.

.|
PC Camera Module (Windows 7) E - 19
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Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk space for each file. After
recording video, check thevideo file size (right-click thefile and select Pr oper ties) and the remaining free space
on your hard disk (go to My Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to aremovable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows system requires a minimum of 15GB of free space on the C: drive system partition. In
order to prevent system problemsit isrecommended that you save the captured video file to alocation other than
the C: drive (see“ Set Capture File” on page E - 19), limit the file size of the captured video or reduce video
resolution (see below).

To Reduce Video Resolution Qutput Size:

1. Run the camera application program from the desk-
top shortcut.

2. Goto Options and scroll down to select Video
Capture Pin....

3. Click the Output Size drop box and select a lower
resolution size in order to reduce the captured file
size.

4. Click OK.

Figure E - 10 Output Size (Video Capture Pin)
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Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to
adjust the setting in the Video Capture Filter options.

1. Run the camera application from the desktop shortcut.
2. Goto Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under PowerLine Frequency.

4

Camera Options

The video capture filter
figure pictured here may
appear slightly different
for some camera mod-
ules. To adjust the anti
flicker properties look un-
der the headings Anti
Flicker/Frequency/Pow-
erLine Frequency.

PC Camera Module (Windows 7) E - 21

Windows 7

\N A/

L&
Latest PC Camera
Driver Information

Check the Device Driv-
ers & Utilities + User’s
Manual disc, and any
accompanying insert

pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here, including the fig-
ures pictured.

Figure E - 10
Video Capture Filter
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Taking Still Pictures
& The camera application allows you to take still pictures.

Snapshot Folder 1. Run the camera application from the desktop shortcut.

2. Goto Options and select Take Picture.

3. The picture (in JPEG format) will be placed in the Snapshot folder on the
desktop.

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.
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Wireless LAN (Windows 7) S

SV
If you have included an Intel® or 3rd Party WirelessLAN (or WLAN & Bluetooth _ /Z’l\ _
combo) module in your purchase option, make sure that the WLAN module is on be- BHITENESs DEVee

- . - Operation Aboard
foreinstalling the driver. Aircraft

Usethe Fn + F11 key combination (see Table 1 - 3, on page 1 - 10) to toggle power B IMEREEEE AL E IS
to the WirelessL AN module. Make sure you install the driversin the order indicated [l it LSSy

. devices aboard aircraft
inTable E -2, on page E - 10. is usually prohibited.

Make sure the mod-
Note that you need to install both the WLAN & Bluetooth driversfor the Intel and FRUEE RIS

3rd party WLAN & Bluetooth Combo modules. using the computer
aboard aircraft.
Use Fn + F11 Airplane
Mode key combination
to toggle Airplane Mode
On/Off, and check the
LED indicator for the
power  status (see

).
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Intel® WLAN Driver Installation

1. Make sure the moduleis powered on, and then insert the Device Drivers & Utilities + User’s Manual
disc into an attached DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Click in the check box to agree to the End User License Agreement and click Install.

Click Finish.

The operating system is the default setting for Wireless LAN control in Windows (see page E - 25).
OR

3rd Party WLAN Driver Installation

1. Make sure the moduleis powered on, and then insert the Device Drivers & Utilities + User’s Manual
disc into an attached DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Click Next.
Click Finish to restart the computer.
The operating system is the default setting for Wireless LAN control in Windows (see page E - 25).

OOrWN
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Connecting to a Wireless Network in Windows 7

Make sure the Wireless LAN moduleisturned on. /
1. Click the taskbar notification area wireless icon ﬂ-, and then double-click an Network and
access point to connect to or click to Open Network and Sharing Center if you do Sharing Center

not see a network you want to connect to in the taskbar menu (a list of options will

appear allowing setting changes, and creating a new network). VeLean 2l e s e

work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure E - 11
Click Taskbar Icon
Menu & Network
and Sharing Center
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2. You may need to enter a security key for any access point to which you are trying to
connect.

3. Click to select a network location (e.g. Home, Work or Public).

4. Click “View or change settings in Network and Sharing Center” to access
further options for the connection.

Figure E - 12
Network Location
Set
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5. Click the taskbar icon g to see any currently connected networks.
. . . . . . \ A/
6. To disconnect from the wireless network you can click the taskbar wireless icon ., ﬂ:

click the active connection and then click Disconnect (button). Security Enabled

Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure net-
works may allow unauthor-
ized access to your
computer, documents, web-
sites and files etc.

Figure E - 13
Click Taskbar Icon
Menu - Disconnect
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Bluetooth & WLAN Combo Module (Windows 7)

N
/Z’l\ If your purchase option includes the Intel® or 3rd Party Combination Wireless

Wireless Device LAN & Bluetooth module then install the driver asinstructed overleaf.
Operation Aboard

Aircraft Make sure that the module ison (i.e. the system isnot in Airplane M ode) before in-

The use of any portable stalling the driver.

electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are

4

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported

using the computer

aboard aircraft. in one direction only (simultaneous data transfer is not supported). Therefore if you are copying

a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.

Use Fn + F11 Airplane
Mode key combination
to toggle Airplane Mode
On/Off, and check the
LED indicator for the
power  status (see

).
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Intel Bluetooth Combo Driver Installation

1.

NoOk~WN

Make sure the module is powered on, and then insert the Device Drivers &
Utilities + User’s Manual disc into an attached DVD drive.

Click Option Drivers (button).

Click 3.Install Combo BT Driver > Yes.

Click Next > Next.

Click in the check box to accept the license and click Next > Next.

Click Finish > Yesto restart the computer.

See “Bluetooth Configuration in Windows 7’ on page E - 30 for configu-
ration instructions.

OR

3rd Party Bluetooth Combo Driver Installation

1.

oOuhkwN

Bluetooth & WLAN Combo Module (Windows 7) E - 29

Make sure the module is powered on, and then insert the Device Drivers &
Utilities + User’'s Manual disc into an attached DVD drive.

Click Option Drivers (button).

Click 3.Install Combo BT Driver > Yes.

Click Next.

Click Finish to restart the computer.

See “ Bluetooth Configuration in Windows 7’ on page E - 30 for configu-
ration instructions.

Windows 7

4

High Speed Bluetooth
Data Transfer

The Combination Wire-
less LAN & Bluetooth
module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.

Check your Bluetooth
compatible device’'s doc-
umentation to confirm it
supports high speed data
transfer.
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Bluetooth Configuration in Windows 7

/ 1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
Add a Device 2. Make the device discoverable (to do this check your device documentation).
3. Make sure the computer is not in Airplane Mode (if Airplane Mode is on then the

Gl SElG Il (&[5 S(Ch I Bluetooth module will be off).

trol Panel and then click

Devices and Printers | 4- A Bluetooth icon [J will appear in _the notification area. _
(Hardware and Sound). | 5. You can then do any of the following to access the Bluetooth Devices control
Click Add a device to panel.
search for any available
Bluetooth devices. »  Double-click the notification area icon E to access the Bluetooth Devices control panel.
*  Click/Right-click the notification area icon E and choose an option from the menu.
Figure E - 14

Bluetooth Devices &
Click Icon Menu

Add a device Right-Click Notification Area Icon E
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To Add a Bluetooth Device

1. Access the Bluetooth Devices control panel and click Add a device. /
2. Double-click the device you want to pair with the computer.

Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure E - 15

) . . ) . . Add a Device
3. Onfirst connection the computer will provide you with a pairing code to be entered

onto the device.
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Figure E - 16
Pairing Code
Example

Figure E - 17
Pairing Complete &
Bluetooth Device
Enabled

4. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

4

Pairing Codes

The example outlined here shows a connection to a
mobile device. Other devices e.g. computers, may
have a slightly different connection procedure, and
may require you to confirm a pairing code is correct
on both devices. Follow the on-screen instructions to
complete the pairing.

5. Windows will check to see if any drivers are required to complete the pairing.

6. Follow any on-screen instructions on the computer if device drivers are required to
be installed.

7. Click Close.

E - 32 Bluetooth & WLAN Combo Module (Windows 7)



Windows 7

To Change Settings for the Bluetooth Device
1. Click the notification area icon and select Show Bluetooth Devices. /
2. Right-click on the device you want to change and click Properties to:

* Change the name of the device (click Bluetooth, type a new name and click OK).
+ Enable/Disable a service (click Services, clear/check the check box next to the service and click OK). To get help on Bluetooth

Bluetooth Help

configuration and set-

To Make your Computer Discoverable to Bluetooth Devices s, den LHm and

1. Click the notification area icon and select Open Settings. Support from the Start
2. Click Options, and make sure that Allow Bluetooth devices to find this menu. Type Bluetooth in
computer check box (Discovery) has a check inside it. the Search Help box, and
3. Make sure that the Alert me when a new Bluetooth device wants to connect select an item from the re-
check box (Connections) has a check inside it, if you want to be notified when a turned search results to
Bluetooth device wants to connect. get more information.
Figure E - 18
Bluetooth Settings -
Options
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3G/4G Module (Windows 7)

If you have included an optional UM TS/HSPA+ based 3G Module (Universal Mobile Telecommunications
System or High Speed Packet Access) module or LTE (Long Term Evolution) 4G module (see “ Communica-
tion” on page D - 3 for specification details) in your purchase option, you will have the appropriate driver pro-
vided for Windows 7 (Windows 8.1 does not require a driver/application). Follow the instructions on page E -
35toinstall the USIM card (which will be provided by your service provider), and then install the driver.

N2
2

Important Notice - 3G/4G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G/4G module and
the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency,
and cause interference. When the 3G/4G module is powered on, make sure that the Blue-
tooth/Wireless LAN modules are powered off.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibit-
ed. Make sure the WLAN, Bluetooth and 3G/4G module(s) are OFF (or the system is in
Airplane Mode) if you are using the computer aboard aircraft (see

).
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3G/4G Module USIM Card Installation
Follow the instructions below to install the USIM card (which will be provided by your service provider).

Turn the computer off, and turn it over.

Slide the latch @ in the direction of the arrow.

Slide the latch @ in the direction of the arrow, and hold it in place.

Slide the battery out in the direction of the arrow @.

Insert the USIM card @) as illustrated below until it clicks fully into position, and replace the battery.
Press the USIM card to eject and remove it @.

(3] RS

9 9 USIM Card Orientation

ok wbNE

Note that the USIM card’s readable side (with the gold-
colored contacts) should face upwards as illustrated.

e e USIM Card Ejection

Simply press on the USIM card to eject it, however do
not do this while a connection is in progress. If you do
eject the card while a 3G/4G connection is ongoing,
you will need to shut down the system, reinsert the
USIM card, restart the system and then reestablish the
3G/4G connection.If you wish to change USIM cards
then you will need to shut the system down, reinsert the
USIM card, restart the system and then reestablish the
3G/4G connection.

2N
PR

Power Safety Warning

Before you undertake any installation procedures, make sure that you have
turned off the power, and disconnected all peripherals and cables (including
telephone lines).
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Figure E - 19 - Battery Removal & USIM Card Insertion
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3G/4G Driver

With the 3G/4G module and USIM card (supplied by your service provider) installed you may then install the
driver below to directly access your 3G/4G internet service from the computer.

3G/4G Driver Installation

1. Make surethe systemisnot in Airplane Mode.

2. If aFound New Hardware window appears, click Cancel (click Cancel for al Found New Hardware
windows that appear).

3. Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.

4. Click Option Drivers (button).

5. Click 4.Install 3G/4G Driver > Yes.

6. Click Next.

7. Click | Agree (button) to accept the license agreement.

8. Click Install.

9. Click Finish.

10. See over for 3G/4G connection information.
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Connecting to a 3G/4G Network in Windows 7

1. Click the taskbar notification area wireless icon ["jjiil]l . and then click the
access point name (if your SIM card is installed the service provider should appear
here) and then click Connect.

< > Figure E - 20

3G/4G Network
Connection
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n

A subscription details window will pop-up on the first run of the connection only.
3. You will need to enter the name of your Access Point, User Name and Password
(this information will be supplied by your service provider, and not all fields are
necessarily required).

After entering the information click Continue.

You will then be prompted to select your Autoconnect Settings (on the first run
of the connection only).

6. After selecting your preference click Connect to initiate the connection.

ok

Figure E - 21
Subscription
Details &
Autoconnect
Settings
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7. You can then access the internet, download e-mail etc. as per any internet
connection.

8. While connected you can also click the icon [EM in the notification area of the
taskbar to display the connection status.

9. To disconnect from the 3G/4G network you can click the active connection and
then click Disconnect (button).

Figure E - 22
Disconnect From
the Network

=
>
o
(@]
=
wn
~

.|
3G/4G Module (Windows 7) E - 39



Windows 7

Intel Rapid Storage Technology (Windows 7)

Install the Intel Rapid Storage Technology to support your SATA drive set up in AHCI mode in the BIOS (see
“SATA Mode (Advanced Menu)” on page5 - 7).

IRST Driver Installation

Insert the Device Drivers & Utilities + User’s Manual disc an attached DVD drive.

Click Option Drivers (button).

Click 5.Install IRST Driver > Yes,

Click Next.

Click in the check box to accept the license and click Next.

Click Next > Next > Next.

Click Finish to restart the computer (you will need to restart the system again after the computer has
rebooted).

Run the Intel® Rapid Storage Technology application from the Start menu.

NogkrwdpE
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Intel® Wireless Display Application (Windows 7)

The Intel® Wireless Display Application (requires|Intel® WLAN/Combo mod- /_
ule), in conjunction with acompatible video adapter (purchased separately), allows Compatible
you to display the contents of the notebook display on another display (e.g. HDTV) Adapters

without the need to have cables stretching across aroom. Y ou can then play games, | For a list of compatible
browse the internet, display videos or photo slide shows on your TV/external display | display and audio adapt-

without using HDMI or A/V cables. ers check the Intel web-
site, or your distributor/

lier.
Before configuring the Intel® WiDi application you will need to set up your com- SUPPIET

patible adapter with your display/speakers. Connect the adapter using an HDMI or
A/V cable and turn on the display (or in the case of speakers connect them to the
wireless speaker adapter with the cables provided with the adapter), and then set the
display to the appropriate input channel (see the documentation supplied with your
compatible adapter for full details).

Intel® WiDi aso incorporates Intel® Wireless Music which allows you to wire-
lessly stream audio from your computer to speakers connected to acompatiblewire-
less speaker adapter (purchased separately).
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Intel® WiDi Application Installation

Insert the Device Drivers & Utilities + User’s Manual disc an attached DVD drive.
Click Option Drivers (button).

Click 6.Install WiDi AP > Yes.

Click Next.

Click the button to accept the license and click Next.

Click Finish.

oukwNE
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Intel® WiDi Application Configuration

1. Click Start > All Programs > Intel Corporation > Intel(R) Wireless Display >
Intel(R) Wireless Display, or double click the icon on the desktop.

2. Click I agree to the terms of this license (button).

3. The application will scan for any connected compatible adapters (or you can click
the Scan for available adapters button to enable Intel My WiFi Technology).

Figure E - 23
Intel® WiDi Scan
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4. Click to select and detected adapters, and click Connect.

5. The system will then prompt you to enter the 4-digit security code which will be
displayed on the external TV Screen (or press the connect button on the wireless
speaker adapter).

6. Enter the code for the video adapter and click Continue.

Figure E - 24
Intel® WiDi Connect
& Enter Security
Code
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7. You will then be prompted to enter a name for the video adapter and click

Continue. 4

8. Click Finished to complete the setup.

Test Audio Adapter

To verify a successful
audio connection (for In-
tel® Wireless Music),
select the “Test your
audio connection” link
or select “Finished” to
bypass the test.

You can select “Play
C) Sample” to play an au-
dio test sample from
your adapter to the con-
nected speaker set.

N
V

Figure E - 25
Intel® WiDi
Connected
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Appendix F: Windows 10

Overview

This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows 10 OS.

Y ou can refer to the main manual for details of audio & video information, BIOS, modules etc. However drivers
information specific to Windows 10 will be included in this Appendix, as well as details on how to navigate the
Windows 10 user interface to access the applications, control panels, taskbar etc. Note that Windows 10 will be
subject to constant updates and revisions, and some of the screens pictured throughout this chapter may change
over the course of time and appear differently from those illustrated.

4

Windows 10 OS

In order to run Windows 10 (64 bit) your computer requires a minimum 2GB of system memory (RAM).

Overview F-1

=
>
Q.
o
=
n
[EEY
o




Windows 10

Windows 10 Start Menu

Most of the apps, control panels, utilities and programs within Windows 10 can be accessed from the Start

Menu by clicking theicon gg in the taskbar in the lower |eft corner of the screen (or by pressing the Windows
Logo Key 2@ on the keyboard).

Figure F - 1 - Windows Start Menu
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Right-Clicking the Windows Logo In Start Menu

Right-click the Start Menu gg icon (or use the Windows Logo Key g@ + X key combination) to bring up an
advanced Context M enu of useful features such as Control Panel, Programs and Features, Power Options, Task
Manager, Search, File Explorer, Command Prompt, Device Manager and Network Connections etc.

Right-Click Icon

Figure F - 2 - Right-Click Windows Logo in Start Menu

Windows 10 Start Menu F - 3
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Start Menu Apps & Tiles

The Windows 10 Start Menu will contain a number of apps, and many more will be installed as you add more
applications etc. Not al of these apps can fit on the screen so may need click and drag the handles at the edge of

the screen to expand the menu in order to view all the apps (you can use the scroll bar to move up and down the
screen).

Figure F - 3 - Expanding the Start Menu
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Pining/Unpinning Apps & Programs to/from the Start Menu

To make things easy to find you can add and remove tiles for apps and programs to the Start Menu. Right-Click
on aprogram’sicon and select Pin to Start from the drop-down menu. To remove an app or program from the
Start Menu right-click the icon and select Unpin from Start. Y ou can use the same method to pin apps/pro-
gramsto/from the taskbar (select pin to taskbar/unpin this program from the taskbar).

Figure F - 4 - Pin to Start/Unpin from Start

. |
Windows 10 Start Menu F -5
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Windows 10 Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel can be accessed in a number of waysin Windows 10.

* Right-click the Start Menuicon
2a inthetaskbar in the lower |left
corner of the screen and select
Control Panel from the menu.

* Pressthe Windowslogo key s
on your keyboard and X to bring
up the context menu, and then
press P to bring up the Control
Panel.

» Type Control Panel into the
Search box in the taskbar and
click on the icon when it pops up.

Figure F - 5 - Windows 10 Control Panel Access
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Settings

The Settingsitem in the Start Menu (and also as an App) gives you quick access to anumber of system settings
control panels allowing you to adjust settings for System, Devices, Network & internet, Personalization, Ac-
counts, Time & language, Ease of Access, Privacy and Update & security.

Figure F - 6 - Settings

. |
Windows 10 Control Panel F-7
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Windows 10 Taskbar

In many instances throughout this manual you will see an instruction to access the notification ar ea of the task-
bar. The notification area of the taskbar in the bottom right of the screen. Some of the Control Panels and appli-
cations referred to throughout the course of this manual can be accessed from here.

Taskbar

Taskbar - Pinned Programs and Apps Notification Area
Figure F - 7 - Taskbar

Y ou can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see “ Pining/
Unpinning Apps & Programs to/from the Start Menu” on page F - 5).
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Video Features

Y ou can switch display devices, and configure display options, from the Display control panel (in Appear ance
and Per sonalization). Click Adjust resolution to make changes to the appearance of the display and to detect
and configure any attached displays. In Windows 10 it is possible to quickly configure external displays from
the Proj ect menu (press the Windows logo key g@ on your keyboard and the P key).

To Configure Displays using Project

1. Attach your display to the appropriate
port, and turn it on.

2. Pressthe H@ + P key combination.

3. Click on any one of the options from
the menu to select PC screen only,
Duplicate, Extend or Second
screen only.

4. You can also click Connect to a
wireless display at the bottom of the
Project screen and follow the steps
to connect to any wireless enabled
display.

Figure F - 8 - Project

. |
Video Features F -9
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To access Display (Control Panel) and Screen Resolution in Windows:

1. Gotothe Control Panel.

2. Click Display (icon) - In the Appearance and Personalization category.

3. Make and changes required from the Display, Resolution, Orientation or Multiple display menus.
4. Click Apply to save the settings.

4

Screen Resolution

Use the dropbox to select
the screen Resolution @
(Figure F - 9).

Click Advanced settings
@ (Figure F - 9) to bring up
the Advanced properties
(1] tabs.
. Click Apply to save any
changes made.

Figure F - 9 - Screen Resolution
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Display Settings:

1. You can quickly adjust the display by right-clicking the desktop and selecting Display Settings @.

2. Adjust the settings using the sliders in the menu or click Advanced display settings @ to change resolution.
3. Click Apply to save any changes made to resolution.

(2 [ —

Figure F - 10 - Display Settings
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Power Options

Power Options (Hardware and Sound) can be accessed from the Control Panel. The Power button item in
Start Menu (or the context menu) may be used to Shut down or Restart (you can aso add Hiber nate/Sleep to
the menu - see page F - 13). To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to perform the function selected.

Using the Power Button

1. Go to the Start Menu.

2. Click the Power button

3. Select the power state required
from the menu.

Figure F - 11 - Shut Down/Restart
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Y ou can also use the context menu (right-click the Start Menu gg icon or pressthe Windows logo gg + X key
combination) to Sign out, Sleep, Hibernate, Shut down, and Restart.

4

Adding Hibernate/Sleep to the Power Men

1. Go tothe Power Options (Hardware and Sound)
control panel.

2. Click Choose what the power buttons do.

3. Click “Change settings that are currently
unavailable” By Change settings that are currently unavailable .

4. Click to put a check in the Hibernate/Sleep box
under Shutdown settings.

5. Click Save Changes and close the control panel.

Figure F - 12 - Context Menu Shut Down or sign out

Ctrl + Alt + Delete Key Combination

You can usethe CTRL + ALT + DEL key combination to bring up a full-screen displaying L ock, Sign out,
Changeapassword, Task Manager and Switch User. If you click the Power iconin the lower right corner of
the screen a power management option menu appears to display Sleep, Hibernate, Shut down, and Restart.

Power Options F - 13
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Minimum Screen Resolution Settings

1. Windows 10 has minimum screen resolution requirements.

2. Right-click a blank area of the Desktop and select Screen Resolution (or go to the Display control panel).
3. Adjust the Resolution to make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above.

Figure F - 13 - Screen Resolution
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Windows 10 Drivers & Utilities

Make sureyouinstall all thedriversand utilitiesfor your Windows 10 system as outlined in the following pages.

Driver Installation (Windows 10)

1. Insert the Device Drivers & Utilities + User’s Manual disc into the computer’s DVD drive, or an attached DVD
drive if applicable.

2. Click the message “Tap to choose what happens with this disc.”

3. Click Run autorun.exe.

4. Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

5. Check the driver installation order from Table F - 1, on page F - 16 (the drivers must be installed in this
order) which is the same as that listed in the Drivers Installer menu below.

6. Click to select the driver you wish to install, (you should note down the drivers as you install them).

7. Follow the instructions for each individual driver installation procedure as listed on the appropriate pages.

4

Driver Installation

If you miss the message above you can eject the De-
vice Drivers & Utilities + User's Manual disc and then
reinsert it.

Alternatively double-click the disc icon in Comput-
er (use the Windows logo key == + E key combina-
tion to go to Computer in Windows Explorer).
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Windows 10 (64-bit) Drivers

Chipset Page F - 17 Wireless LAN Module Page F - 19
Video (VGA) Page F - 17 Bluetooth & WLAN Combo Module Page F - 21
LAN Page F - 17 Intel® Rapid Storage Technology Page F - 24
CardReader Page F - 17 PC Camera (No driver required) Page F - 25
Touchpad Page F - 17 Trusted Platform Module (No driver required) | Page F - 26
Control Center | Page F-18 3G/4G Module (No driver required) Page F - 27
Airplane Page F - 18

MEI Driver Page F - 18

Audio Page F - 18

Table F - 1 - Driver Installation
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Driver Installation Procedure

Insert the Device Drivers & Utilities+ User’s Manual
disc and click Install Drivers (button).

Chipset

1. Click Llnstall Chipset Driver > Yes.
2. Click Next > Accept > Install.

3. Click Finish > Restart Now.

Video (VGA)

1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Note: After installing the video driver go to the Dis-
play/Display Settings control panel to adjust the vid-
€0 Settings to the highest resolution.

Windows 10

LAN

Note: If the computer enters a deep sleep mode during
installation, you will be prompted to plug in a network
cable, and click OK, to continue installation. If a net-
work cable is not available, restart the system and re-
install the LAN driver.

1. Click 3.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.

CardReader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad

1. Click 5.Install Touchpad Driver > Yes.

2. Click Next.

3. Click the button to accept the license agreement
and click Next.

4. Click Finish > Restart Now to restart the com-
puter.

Windows 10 Drivers & Utilities F - 17
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Control Center

1. Click 6.Install Control Center AP > Yes.
2. Click Next > Install.

3. Click Finish to restart the computer.

Airplane

Note: Do not use Update Driver in Device Manager to
install the Airplane Mode driver.

1. Click 7.Install Airplane Driver > Yes.

2. Click Next > Install.

3. Click Finish to restart the computer.

MEI Driver

1. Click 8.Install MEI Driver > Yes.

2. Click Next.

3. Click the check box to accept the license and
then click Next.

4. Click Next.

5. Click Finish.

Audio

1. Click 9.Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, gject
the Device Drivers & Utilities + User’s Manual disc
and thenreinsert it (or double-click thedisciconinMy
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.

Optional Drivers

See the following pages for the driver installation pro-
ceduresfor any modulesincluded in your purchase op-
tion.

Note that you need to install both the WLAN & Blue-
tooth drivers for the WLAN & Bluetooth Combo
modules.

F - 18 Windows 10 Drivers & Utilities
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Wireless LAN Module

If you have included an Intel® or 3rd Party WL AN modulein your purchase option make sure that the module

ison (i.e. the system is not in Airplane M ode) before installing the driver. Make sure you install the driversin
the order indicated in Table F - 1, on page F - 16.

Notethat you need toinstall both the WLAN & Bluetooth driversfor the WLAN & Bluetooth Combo modules.

Wireless Device
Operation Aboard Aircraft

The use of any portable electronic
transmission devices aboard aircraft is
usually prohibited.

Make sure the module is either OFF or
in Airplane mode if you are using the
computer aboard aircraft.

Wireless LAN Module F - 19
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Windows 10

3rd Party WLAN Driver Installation

1.

NoOoORrWN

Make surethe system isnot in Airplane Mode, and then insert the Device Drivers & Utilities +
User’s Manual disc into the DVD drive.

Click Option Drivers (button).

Click 1.Install WLAN Driver > Yes.

Click Next.

Click Finish to restart the computer.

The operating system is the default setting for Wireless LAN control in Windows 10.

Click the Wireless icon §i@ in the notification area of the taskbar and double-click an access point to
connect to it (or click it and click Connect).

Intel® WLAN Driver Installation

1

NoarwDN

Make surethe system isnot in Airplane Mode, and then insert the Device Drivers & Utilities +
User’s Manual disc into the DVD drive.

Click Option Drivers (button).

Click L.Install WLAN Driver > Yes.

Click in the check box to agree to the End User License Agreement and click Install.
Click Finish.

The operating system is the default setting for Wireless LAN control in Windows 10.

Click the Wireless icon @ in the notification area of the taskbar and double-click an access point to
connect to it (or click it and click Connect).

F - 20 Wireless LAN Module
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Bluetooth & WLAN Combo Module

If your purchase option includes the Combination WirelessLAN & Bluetooth module (either Intel® or 3rd
Party) theninstall the driver asinstructed overleaf (two driversare provided for the 3rd party WLAN module and
one for the Intel WLAN module). Make sure you install the drivers in the order indicated in TableF - 1, on
page F - 16.

Make sure that the module ison (i.e. the systemis not in Air plane M ode) before installing the driver.

4

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported
in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.

2NZ
2L &

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibit-
ed. Make sure the module is either OFF or in Airplane mode if you are using the computer
aboard aircraft.
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Windows 10

3rd Party Bluetooth Combo Driver Installation

1.

oOUhkwWN

Make surethe system isnot in Airplane Mode, and then insert the Device Drivers & Utilities +
User’s Manual disc into the DVD drive.

Click Option Drivers (button).

Click 2.Install Combo BT Driver > Yes.

Click Next.

Click Finish to restart the computer.

See “ Bluetooth Configuration” on page F - 23 for instructions on configuring Bluetooth connections.

Intel Bluetooth Combo Driver Installation

=

ONoOAWN

Make surethe system isnot in Airplane Mode, and then insert the Device Drivers & Utilities +
User’s Manual disc into the DVD drive.

Click Option Drivers (button).

Click 2.Install Combo BT Driver > Yes,

Click Next > Next.

Click in the check box to accept the license and click Next.

Select the setup type (Typical is recommended) and click Install.

Click Finish.

See “ Bluetooth Configuration” on page F - 23 for instructions on configuring Bluetooth connections.

F - 22 Bluetooth & WLAN Combo Module
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Bluetooth Configuration

1. Click the Settings item in the Start Menu and then click Devices.

2. Click Bluetooth and make sure Bluetooth is On and a list of discovered devices will appear.

3. Double-click the device you want to pair with the computer and click Pair.

4. On first connection the computer will provide you with a pairing code to be entered onto the device.

5. Enter the code into your Bluetooth enabled device and click Yes on the computer to complete the pairing.

6. Select a device and click Remove Device to disconnect from any device.

7. Click More Bluetooth Options, and make sure that Allow Bluetooth devices to find this computer check
box (Discovery) has a check inside it.

8. Make sure that the Alert me when a new Bluetooth device wants to connect check box (Connections) has

a check inside it, if you want to be notified when a Bluetooth device wants to connect.
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Intel® Rapid Storage Technology
Install the Intel® Rapid Storage Technology to support your AHCI mode SATA drive.

IRST Driver Installation

Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
Click Option Drivers (button).

Click 3.Install IRST Driver > Yes.

Click Next.

Click the check box to accept the license and click Next.

Click Next > Next > Next.

Click Finish to restart the computer.

Run the Intel® Rapid Storage Technology app from the All Apps screen (in the Start Menu).

S
Z

IRST and M.2 PCl-e SSDs

ONoA~WNE

Note that Intel® Rapid Storage Technology does not support M.2 SSDs with a PCl-e In-
terface (M.2 SSDs with a SATA Interface are supported).
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PC Camera

Use the Fn + F10 key combination or Control Center button to toggle power to the PC Camera module. When
the PC Cameraisin use the LED indicator to the left of the camerawill be illuminated.

Note that you need to use the Camer a app [[@] in Windows to take pictures and capture video.

1.
2.

how

Make sure the PC Camera is turned on by using the Fn + F10 key combination (or Control Center button).
Run the Camera app from the Start menu by clicking on the Camera app icon @ (you can type “camera” into
the search box to find the Camera app if it is not pinned to the Start menu).

Click to select either photo or video modes.

Click the photo icon to take a picture, and the camera icon will briefly turn yellow as the picture is taken.

Click on the video icon to start video capture (if video capture begins a timer will appear at the bottom of the
screen and the icon will turn yellow).

To stop video capture click the video icon again.

Captured photos and videos will be saved to a Camera Roll folder within the Pictures/Videos folder in This
PC, and to the Photos app stored in the Start menu (type Photos into the search box if you cannot find the

app).

PC Camera F - 25
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Trusted Platform Module

(Optional)

The TPM security chip allows you to create and manage digital certificates for user and platform authentica-
tion. This type of security is usually administered within large enterprises and organizations, and therefore re-
quires implementation by a system administrator before users can access security features.

Make sure you have administrator’ s rights to your computer, and have a Windows password enabled for full se-
curity protection. In addition Make sure you prepare a removable media (e.g. a USB flash drive) to store
passwor ds etc. before beginning the TPM initialization process.

Before setting up the TPM functions you must enable and initialize the security platform (see “Enabling &
Managing TPM” on page 6 - 23).

TPM Management in Windows

1. Goto the Control Panel.

2. Click BitLocker Drive Encryption (System and Security).

3. Click TPM Administration.

4. The TPM Management window allows you to configure the TPM within Windows. As TPM is usually
administered within large enterprises and organizations, your system administrator will need to assist you in
managing the information here.

5. Click Prepare the TPM and follow the instructions in the Wizard to prepare the TPM (this will probably require a
restart of the computer and confirmation of the setting changes after restart by pressing the appropriate F key).

6. After the restart the TPM will be prepared and you can then use the Actions menu to Turn TPM off, Change
Owner Password, Clear TPM or Reset TPM Lockout.

7. A wizard will help take you through any setup steps.

=
S
o
o
=
%
=
o

F - 26 Trusted Platform Module




Windows 10
3G/4G Module

If you have included an optional UM TS/HSPA+ based 3G Module (Universal Mobile Telecommunications
System or High Speed Packet Access) module or LTE (Long Term Evolution) 4G module (see “ Communica-
tion” on page D - 3 for specification details) in your purchase option, you do not require a driver/application
installation for Windows 10. See “ 3G/4G Module USIM Card Installation” on page 6 - 29 for instructions on
installing the USIM card (which will be provided by your service provider). See overleaf for connection infor-
mation.

\ A/
2§
Important Notice

If your purchase option includes both Wireless LAN and 3G/4G modules, then the appropriate antennas will be installed. Note
that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in
conjunction with any other antenna or transmitter.

Important Notice - 3G/4G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G/4G module and the Bluetooth/Wireless LAN mod-
ules at the same time as this may disrupt radio frequency, and cause interference. When the 3G/4G module is powered on,
make sure that the Bluetooth/Wireless LAN modules are powered off.

3G/4G Module F - 27
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3G/4G Configuration in Windows 10

Y ou can configure a 3G/4G connection as bel ow, however make sure the system isnot in Airplane Mode before
configuration begins.

Click the Settings item in the Start Menu and then click Network and Internet.

Click Cellular a list of available access points will appear.

Click the access point and click Connect.

The system will connect to your network.

Connected will appear under the connection.

You can then access the internet, download e-mail etc. as per any internet connection.

To disconnect you can select the connection and click Disconnect.

You need to use Airplane Mode aboard aircraft.

You can also click the Wireless icon ji in the notification area of the taskbar, click Cellular and double-click an
access point connect to access the connection information.

©CoNoO~wWNE
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